Legal Notice

For information about NetIQ legal notices, disclaimers, warranties, export and other use restrictions, U.S. Government restricted rights, patent policy, and FIPS compliance, see https://www.netiq.com/company/legal/.

Copyright (C) 2016 NetIQ Corporation. All rights reserved.
Contents

About This Guide 7

1 Accessing the Operations Center Console 9
  1.1 Logging In ......................................................... 9
    1.1.1 Logging In through the Web .................................. 9
    1.1.2 Starting from a Command Line .............................. 10
  1.2 Troubleshooting Java Web Start .................................. 10
  1.3 Logging Out .................................................... 10

2 Understanding the Operations Center Console 11
  2.1 Console Views .................................................. 12
    2.1.1 Summary View ............................................... 12
    2.1.2 Network View ............................................... 12
    2.1.3 Alarms View ................................................. 13
    2.1.4 Layout View ................................................ 13
    2.1.5 Portal View ................................................ 13
    2.1.6 Performance View .......................................... 16
  2.2 Navigating Console Views ....................................... 16
  2.3 Using Menus and Toolbar Options .............................. 17
  2.4 Navigating Element Hierarchies ............................... 17
    2.4.1 Expanding an Element Level ............................... 18
    2.4.2 Collapsing an Element Level .............................. 18
  2.5 Root Elements .................................................. 18
  2.6 Working with Multiple Console Windows ....................... 19
  2.7 Verifying the Server Name .................................... 19

3 Customizing the Console Views 21
  3.1 Customizing the Explorer Pane .................................. 21
    3.1.1 Hiding or Displaying Condition Indicators .............. 21
    3.1.2 Displaying Linked Element Indicators .................... 22
    3.1.3 Displaying Nonsource Element Indicators ............... 22
    3.1.4 Changing the Explorer Pane Width ....................... 22
    3.1.5 Hiding and Restoring the Explorer Pane ................. 22
    3.1.6 Selecting a Root Element When the Explorer Pane Is Hidden 23
  3.2 Bookmarking Elements .......................................... 23
    3.2.1 Understanding Bookmarking in Operations Center ....... 23
    3.2.2 Bookmarking the Current Element ......................... 23
    3.2.3 Bookmarking an Element from a List ...................... 24
    3.2.4 Accessing a Bookmark ..................................... 24
    3.2.5 Removing a Bookmark ...................................... 24
  3.3 Setting the Default View ....................................... 24
  3.4 Working with Tabular Data ...................................... 24
    3.4.1 Sorting Data ................................................ 25
    3.4.2 Hiding, Displaying, and Selecting Columns ............. 25
    3.4.3 Sizing Columns ............................................. 26
  3.5 Customizing View “Look & Feel” ............................... 26
    3.5.1 Changing the Display Font (Summary, Network, and Alarms Views) 27
    3.5.2 Hiding or Displaying Text Labels (Network View) ....... 27
4 Monitoring Elements and Element State

4.1 Monitoring Elements ........................................ 31
4.1.1 Understanding Adapter and Service Model Elements . 31
4.1.2 Understanding Element Condition ........................ 32
4.1.3 Reviewing Element Information ........................... 32
4.2 Viewing Element Properties .................................. 33
4.2.1 Viewing Element Properties and Property Pages ... 34
4.2.2 Copying Element Properties ............................... 34
4.3 Filtering Elements by Condition ............................. 34
4.3.1 Displaying All Elements .................................. 35
4.3.2 Hiding Elements .............................................. 35
4.3.3 Displaying Elements of a Selected Condition ....... 35
4.3.4 Displaying Elements of a Specified Severity ......... 35
4.4 Managing and Unmanaging Elements ...................... 35
4.4.1 Managing an Element ....................................... 36
4.4.2 Unmanaging an Element .................................. 36
4.5 Viewing Root Cause and Impacted Elements .............. 36
4.5.1 Identifying Service Root Causes .......................... 36
4.5.2 Identifying Impacted Services ............................. 37
4.5.3 Navigating Impacted or Root Cause Elements ....... 38
4.5.4 Restricting the Show Impacted Feature ................. 39

5 Exploring Element Hierarchies ................................. 41

5.1 Navigating the View and Exploring Element Hierarchies . 41
5.2 Changing the Viewing Level of the Elements .............. 42
5.3 Selecting the Magnification Level ............................ 43
5.4 Customizing the Display ...................................... 43
5.4.1Display Options ............................................. 43
5.4.2 Selecting Element Node Styles ........................... 43
5.5 Using Configuration Presets .................................. 44
5.5.1 Updating the Configuration for the Current Element . 44
5.5.2 Working with Global and User Presets .................. 45
5.5.3 Creating and Deleting Presets ............................. 47
5.5.4 Using Layout Rendering Features ......................... 48
5.6 Rendering and Exploring Relationships ..................... 56
5.6.1 Understanding Element Relationships .................. 56
5.6.2 Viewing Relationships and Dependencies ............... 56
5.6.3 Exploring Dependency Relationships .................... 57

6 Using Find to Search for Elements ........................... 59

6.1 Conducting a Simple Find ................................. 59
6.2 Using the Advanced Tab .................................... 60
6.3 Using Metamodel Classes or Properties as Search Criteria . 61

7 Filtering and Managing Alarms ............................... 63

7.1 Understanding the Alarms View and Alarm Types ......... 63
7.2 Viewing a Summary of Alarms ............................... 64
7.3 Viewing Alarm Severity .................................................. 65
  7.3.1 Shading or Removing Shading from All Rows ...................... 65
  7.3.2 Viewing Alarm Severity Colors .................................... 65
7.4 Performing a Simple Filtering of Alarms by Severity .................. 65
  7.4.1 Displaying All alarms .............................................. 66
  7.4.2 Hiding Alarms .................................................... 66
  7.4.3 Displaying Alarms of a Selected Severity ........................ 66
  7.4.4 Displaying Elements of a Specified Severity ................. 66
7.5 Filtering Alarms .......................................................... 66
  7.5.1 Displaying or Hiding the Alarm Filter Pane ....................... 67
  7.5.2 Creating an Alarm Filter ........................................ 67
  7.5.3 Applying Filters ................................................ 72
  7.5.4 Changing Filter Order ........................................... 73
  7.5.5 Editing and Deleting Filters ................................... 73
  7.5.6 Reapplying Filters to Update the Alarms View ............... 73
  7.5.7 Disabling Filters ............................................... 74
  7.5.8 Resolving Filters with No Data in Alarms View ............ 74
7.6 Normalizing Time across Computers ................................... 74
7.7 Performing Alarm Operations ......................................... 75
  7.7.1 Accessing Alarm Options ....................................... 75
  7.7.2 Selecting Alarms ............................................... 75
  7.7.3 Pausing and Resuming Alarm Updates ......................... 76
  7.7.4 Acknowledging Alarms ......................................... 76
  7.7.5 Assigning Alarms .............................................. 77
  7.7.6 Clearing Alarms ............................................... 78
  7.7.7 Printing Alarms .............................................. 79
  7.7.8 Exporting Alarm Data ........................................ 79
7.8 Using Alarm Properties ................................................ 79
  7.8.1 Viewing Alarm Properties ...................................... 80
  7.8.2 Displaying a Different Alarm ................................. 80
  7.8.3 Printing Alarm Properties ................................... 80
  7.8.4 Copying Alarm Properties .................................. 80
7.9 Viewing and Managing the Alarm History ............................... 80
  7.9.1 Viewing the Alarm History for Elements ....................... 81
  7.9.2 Changing the Dates for Displaying Historical Alarms .... 81
  7.9.3 Sorting Alarms ............................................... 82
  7.9.4 Changing the Maximum Number of Historical Alarms Displayed 82
  7.9.5 Displaying Record Time ...................................... 83
  7.9.6 Viewing Deleted Alarms in Historical Alarms ............. 83
  7.9.7 Adjusting the Timeline between Real-Time and Alarm History Views 83
  7.9.8 Viewing the Alarm History Property Page ................ 83

8 Charting Performance Data .............................................. 85
  8.1 Understanding the Performance View ................................ 85
  8.2 Understanding the Chart Types .................................... 86
    8.2.1 Line Charts ................................................ 87
    8.2.2 Sted Bar Chart ............................................. 88
    8.2.3 Condition Line Chart ..................................... 89
    8.2.4 Condition Pie Chart ..................................... 89
  8.3 Charting Performance Data ......................................... 90
    8.3.1 Creating Charts .......................................... 90
    8.3.2 Refining the Displayed Chart .............................. 92
    8.3.3 Updating a Chart Group .................................. 93
    8.3.4 Refreshing Performance Data .............................. 94
    8.3.5 Removing Charts ........................................ 94
  8.4 Viewing and Editing Chart Properties ............................. 94
  8.5 Setting Thresholds on Charts .................................... 95
About This Guide

The User Guide provides information on using basic features of the Operations Center console. It provides an overview of the different views available in the Operations Center console and the various types of data accessible from them.

- Chapter 1, “Accessing the Operations Center Console,” on page 9
- Chapter 2, “Understanding the Operations Center Console,” on page 11
- Chapter 3, “Customizing the Console Views,” on page 21
- Chapter 4, “Monitoring Elements and Element State,” on page 31
- Chapter 6, “Using Find to Search for Elements,” on page 59
- Chapter 7, “Filtering and Managing Alarms,” on page 63
- Chapter 8, “Charting Performance Data,” on page 85
- Appendix A, “Main Menu Options,” on page 103
- Appendix B, “Element and Alarm Options,” on page 107

Audience

This guide is intended for all Operations Center console users, especially those users without Administrator privileges.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation included with this product. Please use the User Comments feature at the bottom of each page of the online documentation.

Additional Documentation & Documentation Updates

This guide is part of the Operations Center documentation set. For the most recent version of the User Guide and a complete list of publications supporting Operations Center, visit our Online Documentation Web Site at Operations Center online documentation.

The Operations Center documentation set is also available as PDF files on the installation CD or ISO; and is delivered as part of the online help accessible from multiple locations in Operations Center depending on the product component.

Additional Resources

We encourage you to use the following additional resources on the Web:

- NetIQ User Community (https://www.netiq.com/communities/): A Web-based community with a variety of discussion topics.
Technical Support


Use these resources for support specific to Operations Center:

- Telephone in Canada and the United States: 1-800-858-4000
- Telephone outside the United States: 1-801-861-4000
- E-mail: support@netiq.com (support@netiq.com)
- Submit a Service Request: http://support.novell.com/contact/ (http://support.novell.com/contact/)

Documentation Conventions

In NetIQ documentation, a greater-than symbol (>) is used to separate actions within a step and items in a cross-reference path. The > symbol is also used to connect consecutive links in an element tree structure where you can either click a plus symbol (+) or double-click the elements to expand them.

When a single pathname can be written with a bslash for some platforms or a forward slash for other platforms, the pathname is presented with a forward slash to preserve case considerations in the UNIX* or Linux* operating systems.

A trademark symbol (®, ™, etc.) denotes a NetIQ trademark. An asterisk (*) denotes a third-party trademark.
1 Accessing the Operations Center Console

The Operations Center console acts as a business service control center for exploring, navigating, and managing various business-related elements and views. The following sections explain the different ways to log in to and out of the Operations Center console:

- Section 1.1, “Logging In,” on page 9
- Section 1.2, “Troubleshooting Java Web Start,” on page 10
- Section 1.3, “Logging Out,” on page 10

1.1 Logging In

Operations Center software is a Web-based application that provides a console as the user interface.

The requirements for logging in to the Operations Center console:

- A valid user name obtained from the administrator
- The Operations Center server, which is the workstation that stores the Operations Center application, must be up and running

You can access Operations Center through:

- The Web using Java Web Start
- A command line for remote access

To log in to Operations Center, select the applicable method:

- Section 1.1.1, “Logging In through the Web,” on page 9
- Section 1.1.2, “Starting from a Command Line,” on page 10

1.1.1 Logging In through the Web

Operations Center uses Java Web Start technology to allow users to access the Operations Center console via the Web. Java Web Start is an application-deployment technology that enables users to download and launch applications from the Web without having to first complete a separate installation procedure.

Launch the Operations Center application by navigating in your Web browser to the Operations Center URL (or link) provided by your Operations Center Administrator. If the application does not exist on the computer, Java Web Start automatically downloads all necessary files. It then caches the files on the computer. Re-launch the application at any time, using a desktop icon or a browser link.

Each time you access Operations Center, Java Web Starts automatically updates the application, thus always loading the most recent version.

For additional information, refer to the Oracle Java Web Start Web site.
To access the Operations Center via the Web:

1. Start a Java-enabled Web browser.
2. In the Location/Address field, enter the following Uniform Resource Locator (URL) address:
   http://server_name:80
   where server_name is the Transmission Control Protocol/Internet Protocol (TCP/IP) host name of the server that is running Operations Center and 80 is the default port setting on Windows. On UNIX, the default server port is 8080.
   Your administrator might provide a different URL depending on port settings or additional parameters. For more information about browser defaults, console configuration, and URL parameters, see the Operations Center Server Installation Guide.
3. Click the Login button to open the Login dialog box.
4. Specify the Username and Password.
   Both the user name and password are case-sensitive. If necessary, verify the case and spelling created by the administrator.
5. Confirm login to the appropriate server by checking the server name displayed at the top of the Login dialog box.
6. Click OK to open the Operations Center console.

1.1.2 Starting from a Command Line

Remote users can start Operations Center from the command line. However, a prerequisite is installing the console with the Java Web Start technology.

To log in remotely:

1. Enter the following line at the command prompt:
   start http://server_name/client
   where server_name is the name of the server where Operations Center is installed and running.

1.2 Troubleshooting Java Web Start

If problems occur when accessing Operations Center using Java Web Start, try clearing the cache.

For instructions, see Java’s Web page on clearing the Java cache (http://www.java.com/en/download/help/plugin_cache.xml)

1.3 Logging Out

To log out of the Operations Center console:

1. Do one of the following:
   - From the File menu, select Logoff to log out of Operations Center without exiting.
   - From the File menu, select Logoff and Exit to log out and exit Operations Center.
2. Click Yes to log out.
   The Operations Center console closes. The Login dialog displays if not exiting Operations Center.
Understanding the Operations Center Console

The Operations Center console acts as a business service control center for exploring, navigating, and managing various business-related elements and views. It provides a hierarchical tree view of system objects as well as a type of Service Dashboard consisting of six different views.

The console provides an interface for viewing, navigating, and managing network organizations. It consists of two main panes:

- **Explorer (left pane):** Lists system elements in a hierarchical tree. The Explorer pane functions as one of the main controllers for the console by allowing you to navigate element hierarchies, view element information and perform operations.
  
  For details on the Explorer pane, see Section 2.4, “Navigating Element Hierarchies,” on page 17

- **View (right pane):** Depending on the selected view, the console displays various types of information about the selected element or the element’s children.
  
  For details on the Explorer pane, see Section 2.1, “Console Views,” on page 12 and Section 2.2, “Navigating Console Views,” on page 16.

The type of information displayed in the View pane varies depending on the selected tab:

- **Summary:** View a listing of first-level child elements with status information including current condition, alarm totals, and last reported date/time.

- **Portal:** Administrators can perform multiple functions from this view that contains multiple panels, similar to what is found in the Properties dialog. Actual panels/options vary depending on the type of element selected.

- **Network:** Use this spider tool to see the relationship of elements and explore the various levels of your environment.

- **Alarms:** View and manage alarms for the selected element. Client-side and server-side alarm filters can be created to refine the data seen here.
  
  For instructions on configurations for alarm suppression, server-side alarm filters and other configurations that affect the display of alarms; see “Customizing Monitored Elements and Alarms” the Operations Center Server Configuration Guide.

- **Layout:** View a hierarchical diagram of the element and its children or view custom drawings as created by your Administrator. Layout diagrams provide a visual analysis of critical relationships and conditions across multiple branches of an element hierarchy.
  
  For instructions on creating custom drawings in the Layout View, see the Operations Center Custom Drawing and Layout Guide.

- **Performance:** Chart real-time performance information or historical information such as alarm history to provide an indication of how an element is performing.
  
  For instructions on capturing alarm history and performance metrics, see “Capturing Alarm and Performance History” the Operations Center Server Configuration Guide.
Review the following sections to understand the different views, elements, and how to navigate the console:

- Section 2.1, “Console Views,” on page 12
- Section 2.2, “Navigating Console Views,” on page 16
- Section 2.3, “Using Menus and Toolbar Options,” on page 17
- Section 2.4, “Navigating Element Hierarchies,” on page 17
- Section 2.5, “Root Elements,” on page 18
- Section 2.6, “Working with Multiple Console Windows,” on page 19
- Section 2.7, “Verifying the Server Name,” on page 19

2.1 Console Views

The console provides a hierarchical tree of network organizations, including six different views that are accessed through tabs at the bottom of the window: *Summary, Portal, Network, Alarms, Layout,* and *Performance.*

The information displayed depends on the selected view, and is filtered for the element selected in the Explorer pane. The level of detail displayed depends on the permissions set by the administrator. For more information on permissions, see the *Operations Center Security Management Guide.*

The following sections contain illustrations of the six different views:

- Section 2.1.1, “Summary View,” on page 12
- Section 2.1.2, “Network View,” on page 12
- Section 2.1.3, “Alarms View,” on page 13
- Section 2.1.4, “Layout View,” on page 13
- Section 2.1.5, “Portal View,” on page 13
- Section 2.1.6, “Performance View,” on page 16

2.1.1 Summary View

The *Summary* view displays the first-level child elements of the element selected in the *Explorer* pane. Use the *Summary* view to view condition and summary information about the elements in a hierarchy.

The bottom status bar displays the total number of elements in the *Summary* view and the number of elements currently selected.

For instructions on using the Summary view to manage element status, see Chapter 4, “Monitoring Elements and Element State,” on page 31.

2.1.2 Network View

The *Network* view provides a graphical view of elements and their relationship to other elements within the larger infrastructure. It presents the selected element at the center of the view, with lines connected to first-level child elements. The line colors identify the condition of the child element.

User access privileges determine which elements display in the *Network* view. The currently selected level of the element hierarchy in the *Explorer* pane determines whether the entire network displays, or only a portion of it.
For instructions on using the Network view to navigate and monitor elements, see Chapter 5, “Exploring Element Hierarchies,” on page 41.

2.1.3 Alarms View

The Alarm View displays information about alarms associated with the elements, allowing you to gain insight into the state and activity of your technology components and business services.

Create one or more alarm filters to manage and filter alarms.

For instructions on using the Alarms view to manage and filter alarms, see Chapter 7, “Filtering and Managing Alarms,” on page 63.

2.1.4 Layout View

The Layout view allows you to manage and monitor services using a graphical representation that focuses on the relationships among the elements.

The Layout view is available for all elements, including:

- **Services > Locations**: Displays a global map. Each color-coded geographical site identifies the most severe condition among its child elements.
- **Services > Service Models**: Displays icons representing any element and type of relationship among elements, such as functional organizations or processes. Customize the view using drawing tools.

Your Administrator can customize the Layout view by creating custom drawings. The type and level of drawing is only limited by your creativity.

For instructions on creating custom drawings in the Layout View, see the *Operations Center Custom Drawing and Layout Guide*.

2.1.5 Portal View

The Portal view provides a comprehensive view and management gateway for each system element. It also contains sections for links to other views or related elements, element actions, and element notes. Because options on elements vary depending on the type of element, the number and names of Portal sections vary among adapters and elements.

Access to options depends on the user’s access privileges. Some administrative tasks are easiest when performed in the Portal view. For example:

- Defining users and groups
  
  For information on assigning permissions to users and groups, see the *Operations Center Security Management Guide*.

- Defining automation events
  
  For information on defining automation events, see “Defining and Managing Automation Events” in the *Operations Center Server Configuration Guide*.

- Setting up calendars and schedules
  
  For information on setting up time management objects, see “Time Categories, Calendars, and Schedules” in the *Operations Center Server Configuration Guide*. 
By default, the Portal view displays with its sections collapsed. Table 2-1 shows the sections commonly found in the Portal view.

As you work, the Portal view “remembers” the expanded and collapsed settings for each section. Therefore, as you click from element to element, only the sections you were working in stay open. Taking the same actions on more than one element is especially convenient through the Portal view and saves the time of opening and closing the Property pages for each element.

Table 2-1 describes some of the various options, which vary depending on the type of element selected.

Table 2-1  Standard Portal View Sections

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACCESS CONTROL</td>
<td>Enables administrators to view and define access privileges for an element.</td>
</tr>
<tr>
<td></td>
<td>For information, see “Assigning Privileges to Elements” in the Operations Center Security Management Guide.</td>
</tr>
<tr>
<td>ACTIONS</td>
<td>Performs specific actions on the selected element.</td>
</tr>
<tr>
<td></td>
<td>For example: Acknowledge, Manage, Ping, Trace Route, Unmanage.</td>
</tr>
<tr>
<td></td>
<td>If you have purchased the SLM and the element has performance data, select the Analyze action to open a Performance Analysis window.</td>
</tr>
<tr>
<td>AUDIT</td>
<td>Enable audit events available for administrative elements.</td>
</tr>
<tr>
<td></td>
<td>For information, see “Auditing” in the Operations Center Security Management Guide.</td>
</tr>
<tr>
<td>AUTOMATION</td>
<td>Enables administrators to define a list of automated events and actions for an element.</td>
</tr>
<tr>
<td></td>
<td>For information, see “Defining and Managing Automation Events” in the Operations Center Server Configuration Guide.</td>
</tr>
<tr>
<td>BLACKOUT CALENDAR</td>
<td>Identifies any blackout calendars as defined for the element.</td>
</tr>
<tr>
<td></td>
<td>For information, see “Time Categories, Calendars, and Schedules” in the Operations Center Server Configuration Guide.</td>
</tr>
<tr>
<td>COMMENTS</td>
<td>You can enter comments about the element, and view comment histories.</td>
</tr>
<tr>
<td>CONDITION</td>
<td>Enables administrators to specify the algorithm to use to calculate an element’s condition.</td>
</tr>
<tr>
<td></td>
<td>The Condition tab is available for elements created using event-based adapters only. It is not available for elements created using object-based adapters such as NetIQ, HP OpenView, the Intercommunication adapter, and Spectrum.</td>
</tr>
<tr>
<td></td>
<td>For information, see “Using Algorithms to Calculate Element State” in the Operations Center Server Configuration Guide.</td>
</tr>
<tr>
<td>CONTACT</td>
<td>Enables administrators to specify contact information for elements in the Services hierarchy.</td>
</tr>
<tr>
<td>DEFINITION</td>
<td>Displays the XML code used to generate the element.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ELEMENTS</td>
<td>Enables administrators to specify the elements that drive the element’s alarms and condition. The Elements tab is available for elements under Service Models. For information on Service Models, see the Operations Center Service Modeling Guide.</td>
</tr>
<tr>
<td>IMPACTED</td>
<td>Shows all objects that are affected by the element’s state. For information, see Section 4.5, “Viewing Root Cause and Impacted Elements,” on page 36.</td>
</tr>
<tr>
<td>OBSERVATIONS</td>
<td>Displays comments about the element and its descendents. For example, the number and type of alarms.</td>
</tr>
<tr>
<td>PERFORMANCE</td>
<td>A list of all available performance profiles showing those where the element is a member. Select a profile’s check box to add or remove it from the profile. The Data Warehouse uses profiles to select the elements for which alarm history is collected. For information on creating profiles, see “Capturing Alarm and Performance History” in the Operations Center Server Configuration Guide.</td>
</tr>
<tr>
<td>PROPERTIES</td>
<td>Displays a list of properties for the selected element, including the current condition level and most recent update time. Depending on the element type, other properties can be displayed, including the port number, number of timeouts, heartbeat, reconnected poll, connect mode, filter, and worst application instance. For information on adapter properties, see “Adapter Property Reference” in the Operations Center Adapter and Integration Guide.</td>
</tr>
<tr>
<td>RELATED</td>
<td>Provides links to the parent and descendents of an element using the provided links.</td>
</tr>
<tr>
<td>ROOT CAUSE</td>
<td>Identifies the objects that affects the selected element’s state. The Details pane identifies the hierarchy of the elements involved. For information, see Section 4.5, “Viewing Root Cause and Impacted Elements,” on page 36.</td>
</tr>
<tr>
<td>SERVICE LEVEL AGREEMENTS</td>
<td>Identifies any service level settings or objectives that are defined for the element. To learn more about Service Level Agreements, see the Operations Center Service Level Agreement Guide.</td>
</tr>
<tr>
<td>STATUS</td>
<td>View basic status information for the element.</td>
</tr>
<tr>
<td>VIEWS</td>
<td>Provides links to open views (Summary, Network, Layout, and Alarms) using the provided links.</td>
</tr>
</tbody>
</table>

**TIP:** Right-click the background of any section in the Portal view (except the view’s gray background) to display a menu for the selected element.
2.1.6  Performance View

The Performance view charts system performance in real time, including historical performance data for elements associated with specific management systems or with the Service Level Manager (SLM), which is a product of Operations Center for managing service level agreements (SLAs).

For information on charting performance data, see Chapter 8, “Charting Performance Data,” on page 85.

For details on configurations for capturing historical data or default chart settings, see “Capturing Alarm and Performance History” in the Operations Center Server Configuration Guide.

For information on using the Performance view in connection with SLM and SLAs, see the Operations Center Service Level Agreement Guide.

2.2  Navigating Console Views

The View pane displays details about the element or children of the element selected in the Explorer pane. There are six view tabs (Summary, Portal, Network, Alarms, Layout, and Performance) along the bottom of the View pane.

The View title bar displays the name of the element currently selected in the Explorer pane. Information about the element’s children displays in the View pane. The level of detail displayed depends on the permissions set by the administrator. For more information on permissions, see the Operations Center Security Management Guide.

To access a view:

1. Click the desired tab at the bottom of the View pane. Table 2-2 list the console views.

<table>
<thead>
<tr>
<th>View Name</th>
<th>Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary</td>
<td>Ctrl+1</td>
<td>Lists the condition of all subelements as well as the last reported date and time and notes about specific elements.</td>
</tr>
<tr>
<td>Portal</td>
<td>Ctrl+2</td>
<td>Provides a gateway into different areas that contain information about a selected element. Administrators use this view to modify the profile of a group, start or stop an adapter, and so on, from a single screen.</td>
</tr>
<tr>
<td>Network</td>
<td>Ctrl+3</td>
<td>Displays a graphical representation of the selected element in relation to all connected elements in the network.</td>
</tr>
<tr>
<td>Alarms</td>
<td>Ctrl+4</td>
<td>Displays a list of alarms associated with the selected element.</td>
</tr>
<tr>
<td>Layout</td>
<td>Ctrl+6</td>
<td>Displays a graphical representation of element relationships.</td>
</tr>
<tr>
<td>Performance</td>
<td>Ctrl+7</td>
<td>Graphs performance data for specified elements if historical data is available.</td>
</tr>
</tbody>
</table>

The selected view displays.
2.3 Using Menus and Toolbar Options

Console menu options provide navigating the element hierarchy, console window, and different views. Other options perform tasks such as finding an element, opening new console windows, and changing user passwords. Menu options can vary depending on the type of element and view selected.

The toolbar provides buttons for navigating windows and element hierarchies. The other buttons allow you to locate specific elements and perform routine tasks. The buttons vary depending on the selected view. For example, the Alarms view provides additional toolbar buttons for managing alarm data. The Performance view provides additional buttons to assist with charting performance data.

Table 2-3 lists the available buttons.

Table 2-3 Console Toolbar Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>Displays the previous view.</td>
</tr>
<tr>
<td>Forward</td>
<td>Displays the next view. Used with B to retrace steps during the current session. Invalid when viewing the most recent view.</td>
</tr>
<tr>
<td>Up</td>
<td>Navigates up one level in the hierarchy displayed in the Explorer.</td>
</tr>
<tr>
<td>Home</td>
<td>Displays the top level of the selected element’s branch.</td>
</tr>
<tr>
<td>Find</td>
<td>Searches for elements based on specified criteria.</td>
</tr>
<tr>
<td>Chat</td>
<td>Opens a dialog box for communicating with other console users. Note that console users are not able to chat with dashboard users.</td>
</tr>
<tr>
<td>Filter</td>
<td>Suppresses the display of alarms or elements based on severity or condition.</td>
</tr>
</tbody>
</table>

2.4 Navigating Element Hierarchies

The Explorer pane consists of a hierarchy tree that enables drilling down to detailed levels of the objects in a managed organization. The selected root element is the top-level of the hierarchy. The first level beneath the root element consists of the major components defined for the root element. The second level consists of the children of the first level elements. Subsequent levels display the child elements of the previous level.

A $\mathbf{+}$ icon displays next to rolled-up elements that have child elements.

Before displaying elements in the Explorer pane, some management systems must discover elements from the program that controls the communication between a client and an object on a server, such as the Simple Network Management Protocol (SNMP). In such a situation, discovering... displays next to an element to indicate the communication protocol is performing the discovery process. The word retrieving... displays next to elements being retrieved in the console. The communication protocol previously discovered these elements, and they reside on the server.

To expand or collapse an element level:

- Section 2.4.1, “Expanding an Element Level,” on page 18
- Section 2.4.2, “Collapsing an Element Level,” on page 18
2.4.1 Expanding an Element Level

To expand an element level, do one of the following:

- Double-click an element.
- Click next to the element.

A ▶ displays next to expanded elements.

In the documentation, we use the verb “expand” instead of “double-click” or “click the icon” and we sequentially list the elements to be expanded, separated by the > character. For example:

In the Explorer pane, expand the Administration root element > Server.

This means to click the ▶ for Administration to expand its children, then click the ▶ for Server to expand its children. Or, you can double-click Administration and Server to get the same effect.

2.4.2 Collapsing an Element Level

To collapse (roll-up) an element level, do one of the following:

- Double-click an element.
- Click next to the element.

A ▼ displays next to collapsed elements.

In the documentation, we use the verb “collapse” instead of “double-click” or “click the icon”.

2.5 Root Elements

The Explorer pane provides a hierarchical view of elements that represent technology resources, organizational resources, or tasks. The Explorer pane groups all elements under standard root elements. The ability to view individual root elements and their hierarchies depends on assigned permissions.

Select a new root element by using the root element drop-down list. Add new root elements by using the Bookmark feature. For instructions on creating bookmarks, see Section 3.2, “Bookmarking Elements,” on page 23.

To select a root element:

1. Click the arrow next to the current root element and then select a root element from the drop-down list:
   - Enterprise: The topmost element that contains all other root elements as its children.
   - Administration: Intended for administrators to perform administrative and maintenance tasks.
     Only users with administrator permissions can access these elements.
   - Elements: A detailed hierarchy of system and network components with multiple levels of elements defined for adapters.
   - Service Level Agreements: A hierarchy of Service Levels for a service.
     Provides a view of objectives and affected elements.
     For details on using SLAs, see the Operations Center Service Level Agreement Guide.
• **Services:** Groups information into containers defined by the administrator to visualize related elements, such as a corporate organizational hierarchy or geographical sites.

• **Locations:** A branch of the Services hierarchy. *Location* elements typically pertain to geographic sites.

• **Service Models:** A branch of the Services hierarchy. *Service Model* elements define how a set of enterprise resources impacts a business function.

For details on creating elements in the Services hierarchy, see the *Operations Center Service Modeling Guide*.

---

**TIP:** The child elements, which are the elements grouped under a root element, display in the *Explorer* pane.

---

### 2.6 Working with Multiple Console Windows

The Operations Center console allows you to open and work from multiple windows. Open a new window by selecting *Window > New Window* from the menu bar.

Add new windows and drag them to a new position or resize to create the desired workspace.

After maximizing a window, reopen all windows by selecting *Window > Tile*, or *Window > Cascade* from the menu bar.

### 2.7 Verifying the Server Name

When multiple Operations Center consoles are open, there are a few ways to identify the server associated with a particular client:

• View the title bar of the console window, which displays the server name.

• When you select *File > Logoff*, the server name displays in the confirmation dialog box title bar.

• When running under Microsoft Windows, the server name displays in the Operations Center taskbar icon.

• From the *Help* menu, select *About*.
  The server name displays in the About dialog box title bar.

• If you stop and restart the server, the server name displays in the dialog box that offers the option to try reconnecting to the server.
3 Customizing the Console Views

Customize the console views by minimizing the Explorer pane, changing the condition/severity colors, changing fonts or setting background colors, and adding element bookmarks. Operations Center saves these customizations as user settings, so that changes made by one user do not affect other users.

- Section 3.1, “Customizing the Explorer Pane,” on page 21
- Section 3.2, “Bookmarking Elements,” on page 23
- Section 3.3, “Setting the Default View,” on page 24
- Section 3.4, “Working with Tabular Data,” on page 24
- Section 3.5, “Customizing View “Look & Feel”,” on page 26
- Section 3.6, “Managing Condition/Severity Colors,” on page 28

3.1 Customizing the Explorer Pane

It is possible to configure the Explorer pane in various ways. Some configurations are related to the icon indicators next to the element objects in the hierarchy tree. Other options are related to the size and state of the Explorer pane.

- Section 3.1.1, “Hiding or Displaying Condition Indicators,” on page 21
- Section 3.1.2, “Displaying Linked Element Indicators,” on page 22
- Section 3.1.3, “Displaying Nonsource Element Indicators,” on page 22
- Section 3.1.4, “Changing the Explorer Pane Width,” on page 22
- Section 3.1.5, “Hiding and Restoring the Explorer Pane,” on page 22
- Section 3.1.6, “Selecting a Root Element When the Explorer Pane Is Hidden,” on page 23

3.1.1 Hiding or Displaying Condition Indicators

To hide or display the condition indicators in the Explorer pane:

1. In the Explorer pane, right-click the background, then select Show Condition Indicators.

   When selected, condition indicators display.
3.1.2 Displaying Linked Element Indicators

A linked element icon displayed in the Services hierarchy indicates that the element was created elsewhere in the hierarchy and later linked to this parent using the Link option.

Linked elements contribute to the state of the parent unless the link has been severed. For more information, see Section 3.1.3, “Displaying Nonsource Element Indicators,” on page 22

To hide or display linked element indicators:

1. In the Explorer pane, right-click the background, then select Show Linked Element Indicators.

When selected, the linked element indicators display next to elements that are linked from another hierarchy.

3.1.3 Displaying Nonsource Element Indicators

Broken connector lines that display in the Services hierarchy indicate that a child element does not contribute to the state of its parent. This symbol is known as a nonsource contributing link.

The Link option is used to link a Services element as a child of another Services element. In this case, the child to contribute to the condition of the new parent. Removing the link allows the child to still display in that part of the hierarchy, but with its condition no longer affects the parent, as symbolized by the nonsource element link icon:

To hide or display nonsource element indicators:

1. In the Explorer pane, right-click the background, then select Show Non-source Element Indicators.

When selected, the non-source element indicators display next to elements.

3.1.4 Changing the Explorer Pane Width

To expand or reduce the width of the Explorer pane:

1. Click the right border of the pane and drag the mouse to the left or right when a horizontal arrow appears.

3.1.5 Hiding and Restoring the Explorer Pane

- “Hiding the Explorer Pane” on page 22
- “Restoring the Explorer Pane” on page 23

Hiding the Explorer Pane

To hide the Explorer pane:

1. Click the x in the top right corner of the Explorer pane.

The Explorer pane disappears and the View pane maximizes to fill the console. The current the root element name displays in the View pane title bar, under the toolbar menu.
Restoring the Explorer Pane

To restore the Explorer pane:

1. From the View menu, select Explorer Pane to display the Explorer pane.

3.1.6 Selecting a Root Element When the Explorer Pane Is Hidden

To select a new root element when the Explorer pane is hidden:

1. In the View pane title bar, click the root element name to display the Explorer pane.
2. Click the Root Element drop-down list, then select a different root element.
   The title bar and View pane update. The Explorer pane disappears.

3.2 Bookmarking Elements

The root element menu is available at the top of the Explorer pane and allows bookmarks to be created for more custom and easier navigation. It provides a way to access an element, perhaps a child element that is several levels beneath the root, using a single click. Create bookmarks for frequently accessed elements.

- Section 3.2.1, “Understanding Bookmarking in Operations Center,” on page 23
- Section 3.2.2, “Bookmarking the Current Element,” on page 23
- Section 3.2.3, “Bookmarking an Element from a List,” on page 24
- Section 3.2.4, “Accessing a Bookmark,” on page 24
- Section 3.2.5, “Removing a Bookmark,” on page 24

3.2.1 Understanding Bookmarking in Operations Center

Table 3-1 summarizes the Bookmark menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bookmark This Element</td>
<td>Adds the current element currently to the root element selection list.</td>
</tr>
<tr>
<td>Bookmark Element</td>
<td>Opens a dialog box displaying all root element hierarchies to select an element to bookmark.</td>
</tr>
<tr>
<td>Remove Bookmark</td>
<td>Deletes the bookmark that is currently selected as the root element.</td>
</tr>
</tbody>
</table>

3.2.2 Bookmarking the Current Element

To bookmark the current element:

1. Select the desired element in the Explorer pane.
2. Click the root element drop-down list, then select Bookmark This Element.
   A link to the element displays in the root element drop-down list.
3.2.3 **Bookmarking an Element from a List**

To bookmark any element:

1. Click the root element drop-down list, then select *Bookmark Element*. A drop-down list displays the hierarchy for each root element.
2. Select an element at any level, then click *OK* to add it to the root element selection list.

3.2.4 **Accessing a Bookmark**

To access a bookmark:

1. Click the root element drop-down list and then select the bookmark.

3.2.5 **Removing a Bookmark**

To delete a bookmark:

1. Click the root element drop-down list and then select *Remove Bookmark*.

3.3 **Setting the Default View**

The *Summary* view is the default view. The default view opens immediately after selecting any element in the *Explorer* pane.

To change the default view:

1. From the *View* menu, click *Default View*, then select a view type:
   - **None**: The view type does not change after selecting an element in the *Explorer* pane.
   - **Auto-Select**: Operations Center selects a view that corresponds to the type of selected element. For example, if the selected element under the *Administration* root is a folder, such as *Adapters* or *Automation/Repository*, the *Summary* view is the default view.
   - **Summary**: The view changes to *Summary*.
   - **Portal**: The view changes to *Portal*.
   - **Network**: The view changes to *Network*.
   - **Layout**: The view changes to *Layout*.

The selected view displays immediately after selecting any element in the *Explorer* pane.

3.4 **Working with Tabular Data**

You can customize tabular data in the *Summary* and *Alarms* views in the following ways:

- Sort the elements (Summary view) or alarms (Alarms view) by different columns
- Rearrange the order of data columns
- Hide or show columns
- Resize columns
The following sections describe:

- Section 3.4.1, “Sorting Data,” on page 25
- Section 3.4.2, “Hiding, Displaying, and Selecting Columns,” on page 25
- Section 3.4.3, “Sizing Columns,” on page 26

3.4.1 Sorting Data

Some analyses might require sorting elements or alarms in the Summary or Alarms view by a specific data column. When you sort the display of alarms based on any column other than the common columns (Severity, Element, Date/Time, ID), sorting is performed using a string sort, so numeric data values might not sort properly.

To sort elements or alarms by a specific column:

1. In the Summary or Alarms view, click a column heading. The items in the column sort in descending order, as represented by the down arrow icon.
2. Click the heading a second time to sort in ascending order. The up arrow icon displays in the column.
3. Rearrange the order in which the columns display by clicking and dragging a column to a new location.

3.4.2 Hiding, Displaying, and Selecting Columns

- “Hiding Columns” on page 25
- “Displaying a Hidden Column” on page 25
- “Selecting Multiple Columns” on page 26

Hiding Columns

To hide a column:

1. Right-click a column heading. A check mark identifies the columns currently displayed. The column names vary among adapters associated with the alarms.
2. Click More to view additional columns.
3. Click to remove the check mark next to a column name. The column disappears from the Alarms view.
4. To rearrange the order in which the columns display, click and drag a column to its new location.

Displaying a Hidden Column

To display a column:

1. Right-click a column heading. A drop-down list of column headings displays.
2. Select a column name. A check mark displays next to the column and the column displays in the view.
Selecting Multiple Columns

To select multiple columns:

1. Right-click a column heading to display a drop-down list.
2. From the drop-down list, select More to open the Show/Hide Columns dialog box.
3. Do one of the following:
   - Select individual check boxes, or click Check All to select all check boxes.
   - To deselect all columns at the same time, click Check None.
4. Click OK.

The selected columns display in the view and the deselected columns disappear from the view.

The Date/Time column has multiple display options. In addition to the standard mm/dd/yy format, you can specify only a 24-hour clock display without the date, as well as other date/time display combinations.

5. Click the drop-down to view, then select a date and time format.

3.4.3 Sizing Columns

The default column size might make it difficult to read values in specific columns. Use the Fit Columns option to expand specific columns to accommodate the longest text strings that they contain.

To resize columns based on the length of text strings:

1. From the Format menu, select Fit Columns to open its dialog box.
2. By default, all columns are selected.
3. Do one of the following:
   - Deselect individual column names.
   - Click Select All or Select None to select all or none of the columns at the same time.
4. Click OK to resize each selected column to accommodate the longest text string in it.

3.5 Customizing View “Look & Feel”

You can customize the view display in the following ways:

- Change the display font (Summary, Network, and Alarms view)
- Change the background color of the Network view
- Select a specific view as the default

To customize a view display:

- Section 3.5.1, “Changing the Display Font (Summary, Network, and Alarms Views),” on page 27
- Section 3.5.2, “Hiding or Displaying Text Labels (Network View),” on page 27
- Section 3.5.3, “Changing Background Color (Network and Layout Views),” on page 27
3.5.1 Changing the Display Font (Summary, Network, and Alarms Views)

To change the font displayed in the Summary, Network, or Alarms view:

1. In the View pane, select the Summary, Network, or Alarms tab.
2. Click Format, and select one of the following:
   - **Enlarge Font**: Displays the font in the next largest size. Applies to Network view only.
   - **Shrink Font**: Displays the font in the next smallest size. Applies to Network view only.
   - **Set Font**: to change the font type, style or size.

The Select Font dialog box opens.
   - Select the font’s name, style, and size.
   - (Optional) To return to the system default 12 point Dialog font, click Default.
   - Click OK.

The selected font displays in the view.

3.5.2 Hiding or Displaying Text Labels (Network View)

To change the font displayed in the Network view:

1. Select **Display Text** in the Format menu.

When selected, the text labels display. When deselected, all text representing each element disappears and only icons representing the different kinds of elements display.

3.5.3 Changing Background Color (Network and Layout Views)

It is possible to change the background color of the Network and Layout views.

To change the background color:

1. In the View pane, select the Network or Layout tab.
2. Click Format, then select **Choose Background Color** to open the Choose Background Color dialog box.

   **TIP**: This option is also available from the right-click menu on the view background.

3. In the Choose Background Color dialog box, click a tab to open the color selector:
   - In the **Swatches** tab, point, then select a new background color.
   - In the **HSB** tab, select a hue and saturation.
     - Use the scroll bar to select a hue.
     - Click the color in the palette. The selected color appears in the Preview section.
   - In the **RGB** tab, create a new color by specifying red, green, and blue values.
     - Move the Red, Green, and Blue sliders to adjust the RGB values. The selected color appears in the Preview dialog box.
4. Click OK.

The new background color displays in the Network view.
3.6 Managing Condition/Severity Colors

Filtering features in the Operations Center console can hide some elements and their information from a view. You can use the filtering feature in the Summary, Network, Alarms, and Layout views. The condition/severity filter buttons (located on the toolbar) select events using color codes that represent degrees of criticality. The colored buttons display from left to right in order of most critical to least critical. In general, condition refers to elements and severity refers to alarms:

Table 3-2 describes the standard condition/severity color codes and their default definitions from most critical to least critical.

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>CRITICAL</td>
</tr>
<tr>
<td>Orange</td>
<td>MAJOR</td>
</tr>
<tr>
<td>Yellow</td>
<td>MINOR</td>
</tr>
<tr>
<td>Blue</td>
<td>INFORMATIONAL</td>
</tr>
<tr>
<td>Green</td>
<td>OK</td>
</tr>
<tr>
<td>Gray</td>
<td>UNKNOWN</td>
</tr>
<tr>
<td>Brown</td>
<td>UNMANAGED</td>
</tr>
</tbody>
</table>

The color codes help prioritize alarms and events to sort or filter based on condition or severity. For example, sort elements from most critical to least critical, or filter out elements having an OK or INFORMATIONAL condition, to focus on problem areas.

The following sections explain how to modify color themes:

- Section 3.6.1, “Selecting a New Color Theme,” on page 28
- Section 3.6.2, “Modifying Colors in a Scheme,” on page 29
- Section 3.6.3, “Creating a Custom Color Scheme,” on page 29

3.6.1 Selecting a New Color Theme

To select a color from the six default color themes:

1. From the Format menu, select Condition/Severity Colors to open the Condition/Severity Color Settings dialog box.
2. Click the Choose a Supplied Color Theme drop-down list, then select a color theme.
3. Select the Change System Settings check box to set the theme as the default for all users.
4 Click OK.
   The condition/severity codes display using the selected color theme.

### 3.6.2 Modifying Colors in a Scheme

To modify one or more colors in a color scheme:

1. From the **Format** menu, select **Condition/Severity Colors** to open the Condition/Severity Color Settings dialog box.
2. In the **Condition/Severity** section, select a condition color to change. The **Background** and **Foreground Color** drop-down lists activate.
3. Click the **Background** and **Foreground Color** drop-down lists, then select new colors.
4. Select the **Change System Settings** check box to change the theme for all users.
5. Click **OK**.
   The selected condition/severity code displays using the new color.

### 3.6.3 Creating a Custom Color Scheme

It is possible to customize the colors that represent condition/severity levels. There are six default color themes.

To create an additional color theme using the color selector:

1. From the **Format** menu, select **Condition/Severity Colors** to open the Condition/Severity Color Settings dialog box.
2. Click the **Choose a Supplied Color Theme** drop-down list, then select **(Customized)**.
3. Select a color condition to change.
   This activates the **Background** and **Foreground Color** drop-down lists.
4. Click the **Background** and **Foreground Color** drop-down lists, then select new colors.
5. Continue selecting condition/severity codes and changing their background and foreground colors.
6. Select the **Change System Settings** check box to add the theme for all users.
7. Click **OK** to apply the new color theme.
Both alarms and algorithms can contribute to the state (condition) of an element.

Alarms are events associated with specific elements. Each alarm has a severity level. Monitoring an element’s state often involves analyzing the alarms associated with the element. For more information on alarms, see Chapter 7, “Filtering and Managing Alarms,” on page 63.

An algorithm is a sequence of actions that an element can use to change the calculation of its own state. The default method of calculating the state of an element is to use the state of the most critical child element. For details on algorithms, see “Using Algorithms to Calculate Element State” in the Operations Center Server Configuration Guide.

The following sections describe using the Operations Center console to monitor elements and element state:

- Section 4.1, “Monitoring Elements,” on page 31
- Section 4.2, “Viewing Element Properties,” on page 33
- Section 4.3, “Filtering Elements by Condition,” on page 34
- Section 4.4, “Managing and Unmanaging Elements,” on page 35
- Section 4.5, “Viewing Root Cause and Impacted Elements,” on page 36

4.1 Monitoring Elements

The elements available to monitor depend on your access permissions.

The following topics are related to the basic monitoring of elements:

- Section 4.1.1, “Understanding Adapter and Service Model Elements,” on page 31
- Section 4.1.2, “Understanding Element Condition,” on page 32
- Section 4.1.3, “Reviewing Element Information,” on page 32

4.1.1 Understanding Adapter and Service Model Elements

In the Explorer pane, you are likely to have access to the following types of elements:

- **Adapter Elements**: Elements displayed under the Elements root element originate from adapters and are referred to as adapter elements. These elements can be linked to from the Services hierarchy.

- **Service Model Elements**: Administrators can create or import elements in the Services > Service Models hierarchy. These Service Model elements can have custom property pages.

For more information about Service Model elements, see the Operations Center Service Modeling Guide.

For information about various display options in the Explorer pane, see Chapter 3, “Customizing the Console Views,” on page 21.
4.1.2 Understanding Element Condition

In the console, color-coded element conditions help identify critical system events. These condition indicators display for each element in the Explorer and View panes. Condition indicators display as colored diamonds next to each element.

For instructions on hiding or showing the diamond condition indicators in the Explorer pane, see Section 3.1.1, “Hiding or Displaying Condition Indicators,” on page 21.

Condition indicators also display in:

- The Condition/Severity column of the View pane
- The element property pages (see Section 4.2, “Viewing Element Properties,” on page 33)

Table 4-1 describes the standard element condition colors and their default definitions from most critical to least critical.

Table 4-1 Default Element Condition Colors

<table>
<thead>
<tr>
<th>Color</th>
<th>Element Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>CRITICAL</td>
</tr>
<tr>
<td>Orange</td>
<td>MAJOR</td>
</tr>
<tr>
<td>Yellow</td>
<td>MINOR</td>
</tr>
<tr>
<td>Blue</td>
<td>INFORMATIONAL</td>
</tr>
<tr>
<td>Green</td>
<td>OK</td>
</tr>
<tr>
<td>Gray</td>
<td>UNKNOWN</td>
</tr>
<tr>
<td>Brown</td>
<td>UNMANAGED</td>
</tr>
</tbody>
</table>

In many cases, Administrators link an Elements element or Services element as a child of another Services element. In this case, the child to contribute to the condition of the new parent. In the Explorer pane, a linked element icon displays by these elements, indicating that the element was created elsewhere in the hierarchy and later linked to this parent using the Link option.

Removing the link allows the child to still display in that part of the hierarchy, but with its condition no longer affects the parent, as symbolized by the nonsource element link icon in the Explorer pane.

For more information about hiding and showing linked element indicators, see Section 3.1.2, “Displaying Linked Element Indicators,” on page 22

For more information about hiding and showing nonsource elements indicators, see Section 3.1.3, “Displaying Nonsource Element Indicators,” on page 22.

4.1.3 Reviewing Element Information

After selecting an element in the Explorer pane, the View pane updates to display information about the selected element’s children. The information varies among views:

- “Understanding the Summary View” on page 33
- “Understanding the Network View” on page 33
- “Understanding the Layout View” on page 33
Understanding the Summary View

The *Summary view* displays the first-level child elements of the element selected in the *Explorer* pane.

By default, it displays four informational columns, summarized in the following:

- **Element**: Displays the element name.
- **Condition**: Identifies the element’s current condition.
- **Last Reported**: Displays the time of the most recent element condition update.
- **Notes**: Provides a brief remark regarding the element’s condition.

Understanding the Network View

The *Network view* provides a graphical view of elements and their relationship to other elements within the larger infrastructure. It presents the selected element at the center of the view, with lines connected to first-level child elements. The line colors identify the condition of the child element.

User access privileges determine which elements display in the *Network view*. The currently selected level of the element hierarchy in the *Explorer* pane determines whether the entire network displays, or only a portion of it.

Understanding the Layout View

The *Layout view* uses icons to represent system elements and how they relate to each other.

The *Layout view* is available for all elements, including:

- **Services > Locations**: Displays a global map. Each color-coded geographical site identifies the most severe condition among its child elements.
- **Services > Service Models**: Displays icons representing any element and type of relationship among elements, such as functional organizations or processes. Customize the view using drawing tools.

For more information, see the *Operations Center Custom Drawing and Layout Guide*.

4.2 Viewing Element Properties

Property pages display detailed information about an element: Information displayed and the various pages available depend on the type of element. *Administration* property pages are found under an *Administration* folder.

- Section 4.2.1, “Viewing Element Properties and Property Pages,” on page 34
- Section 4.2.2, “Copying Element Properties,” on page 34
4.2.1 Viewing Element Properties and Property Pages

To view element properties:

1. Right-click an element in the View pane, then select Properties to open the Status property page.
   The left pane displays the names of available property pages to display the current property page in the right pane.
   The title displays the element’s short name, condition, and Distinguished Name (DName). Each element has a unique, fully qualified, internal DName, which defines the element’s place in the hierarchy. The DName is read-only, but can be selected and copied to the Clipboard. The DName can be difficult to read, so the element name displays everywhere the DName displays.

2. Click a page name in the left pane to view the selected property page.
   Administration property pages are under an Administration folder. Click ☰ next to the property page name to expand the property page list.
   Users with appropriate access rights can edit the Access Control and Automation property pages.

4.2.2 Copying Element Properties

Text-based element property values can be copied to the Clipboard for pasting in other applications:

- “Copying a Single Text Property” on page 34
- “Copying All Text Properties” on page 34

Copying a Single Text Property

To copy a text property on the page:

1. Right-click a property, then select Copy to place the text on the Clipboard.
2. Paste the text in any other application.

Copying All Text Properties

To copy all text properties on the page:

1. Right-click the right side of the page background, then select Copy All.
   The Copy and Copy All options are also available for text-based alarm properties.

4.3 Filtering Elements by Condition

In the Summary, Network, and default Layout views; all elements display by default.

In the top toolbar, Filter toolbar buttons represent the different condition levels (Critical, Major, Minor, and so on) by showing the associated color. In the Summary view, the number of elements for each condition displays next to button.

Use these Filter toolbar buttons to display or hide elements in the view based on condition.

For more information, see Chapter 7, “Filtering and Managing Alarms,” on page 63.
You can perform the following actions using the Filter section of the toolbar:

- Section 4.3.1, “Displaying All Elements,” on page 35
- Section 4.3.2, “Hiding Elements,” on page 35
- Section 4.3.3, “Displaying Elements of a Selected Condition,” on page 35
- Section 4.3.4, “Displaying Elements of a Specified Severity,” on page 35

### 4.3.1 Displaying All Elements

To display all elements:

1. Right-click any location in the Filter section of the toolbar, then select Reset Filter Settings.

### 4.3.2 Hiding Elements

To hide elements:

1. Click a colored icon to hide elements having that condition.

### 4.3.3 Displaying Elements of a Selected Condition

To display elements of a selected condition:

1. Select or deselect the filter buttons:
   - Elements with the selected condition display.
   - Elements with the deselected condition disappear from the view.

### 4.3.4 Displaying Elements of a Specified Severity

To display elements of a specified severity:

1. Right-click any location in the Filter section of the toolbar, then select Critical/Major/Minor.
   Only the elements with CRITICAL, MAJOR, or MINOR severity display.

### 4.4 Managing and Unmanaging Elements

For some management systems, conditions are not set for unmanaged elements. Eliminating the conditions for some elements reduces the bandwidth and processing time required. You can identify elements as managed using the Manage right-click option, which displays regularly updated condition information.

The managing and unmanaging of elements applies to the following enterprise management systems:

- Computer Associates’ Unicenter (any version) running on a supported platform
- Hewlett Pard OpenView Network Node Manager (version 6.0) running on supported platforms
- Tivoli NetView (versions 5.0) running only on UNIX integrations (the AIX and Solaris platforms)

Using this option requires the Manage permission.
To manage or unmanage an element:

- Section 4.4.1, "Managing an Element," on page 36
- Section 4.4.2, "Unmanaging an Element," on page 36

### 4.4.1 Managing an Element

To start managing an element:

1. Right-click the element, select *Manage*, and then select *Start Monitoring*.
   
   The element's condition changes from UNMANAGED to an updated condition.

### 4.4.2 Unmanaging an Element

To stop managing an element:

1. Right-click an element, select *Manage*, and then select *Stop Monitoring*.
   
   The unmanaged element and its children display, but Operations Center does not update their conditions. Their conditions change to UNMANAGED.

### 4.5 Viewing Root Cause and Impacted Elements

Operations Center provides features for identifying the root cause of a service failure as well as the impact of an element’s failure:

- **Show Root Cause**: Provides a quick way to identify elements that caused a change in the condition of a higher-level element.

  This option is not available for the *Enterprise*, *Administration*, and *Elements* root elements.

- **Show Impacted**: Helps to identify the business services impacted by the failure of lower-level services.

Use these features together to identify dependencies among service objects and to manage the impact of an object on overall service delivery:

- Section 4.5.1, "Identifying Service Root Causes," on page 36
- Section 4.5.2, "Identifying Impacted Services," on page 37
- Section 4.5.3, "Navigating Impacted or Root Cause Elements," on page 38
- Section 4.5.4, "Restricting the Show Impacted Feature," on page 39

### 4.5.1 Identifying Service Root Causes

Use the Root Cause feature to identify lower-level objects that caused a change in the condition of a higher-level object.

Element hierarchies display in their entirety. The Root Cause feature ignores the Display Elements as Children setting for all objects in a hierarchy.

To view *Root Cause* information:

1. Right-click an element in the *Explorer* pane, then select *Show Root Cause* to open its dialog box.

   The Root Cause dialog box consists of the *Root Causes* and *Details* sections.
2 Use the information in the dialog box to identify lower-level elements that affected the change in the higher-level element's condition:

**Root Causes**: Identifies the elements that affected the selected element's state. In the previous illustration, New York Center is down because Port 5 is down and Port 8 is malfunctioning.

**Details**: Identifies the hierarchy of the elements involved. Users who do not have the appropriate security permissions to view an element that is the root cause cannot view the root cause tree that is normally displayed in the *Details* pane.

3 Click *Refresh* to update the following information:

- The state of the selected element and the root cause of the selected element's state
- The service hierarchy definitions in which the selected element participates (Hierarchy files are described in the *Operations Center Adapter and Integration Guide*)
- The state of the root cause element in the service hierarchy definition that impacts the selected element's state
- The state of any element in the service hierarchy definition in which the selected element participates

4 Perform any of the following actions on elements displayed in the Root Cause dialog box:

- Double-click an element.
  The view updates to display information for the element.
- Position the cursor over the element.
  Tooltip information displays for the element.
- Right-click an element, then select a menu option.
  For descriptions of the menu options, see Appendix B, “Element and Alarm Options,” on page 107.

5 In the *Layout* view, display information about an element that is a root cause, perform management operations on the element, then redisplay information about the high-level object to determine if its condition changed.

### 4.5.2 Identifying Impacted Services

The Show Impacted feature identifies higher-level objects that are affected by the condition of a selected element. Use the Impacted dialog box to change the view to any of the impacted objects. Perform operations on them, then return to the originally selected object. Drill up the hierarchy to determine if the selected element impacts multiple services.

Elements in the *Elements* hierarchy are created using adapters, which are the integration points between Operations Center and third-party management systems. For event-based adapters or adapters where the condition is set by a network management system, no elements display as root causes unless algorithms are set to determine the condition. For more information about algorithms, see the *Operations Center Service Modeling Guide*.

Impacted information recognizes security settings and displays only the elements that the user is authorized to view.

To view higher-level objects impacted by a specific element:

1 Right-click an element in the *Explorer* pane, then select *Show Impacted* to open the Impacted dialog box.

In this figure, *Tools* is the selected element. It affects one element at the highest-level. Next to each element is a description of the algorithm that was applied to determine its state.
2 Identify objects impacted by the element by reviewing the Impacted dialog box, which consists of three main sections:

- **Elements Impacted:** Displays the highest-level objects affected by the state of the selected element and the application of algorithms.
- **Details:** Traverses the element hierarchy beginning with the selected object and finishing with the top parent just below the *Enterprise* node. Information about the selected element displays in a shaded block.
- **All Parents:** Displays all potential services impacted by the selected element. Because every element, including Enterprise, has a parent, at least one entry always displays in this section.

**NOTE:** If no objects are impacted, if the impacted objects are not accessible based on security settings, or if the parent object is *Enterprise*, both the *Details* and *Elements Impacted* sections display *None*.

3 Click *Refresh* to update the following information:
- Changes in the state of the selected element and in the impacted services based on the selected element’s state
- Changes in the service hierarchy definitions in which the selected element participates
- Changes in the state of any element in the service hierarchy definition in which the selected element participates

4 Perform any of the following actions on elements displayed in the Impacted dialog box:
- In the *Elements Impacted* section, click the [details] link next to an element.
  - The *Details* section displays the detailed hierarchy between the selected element and the highest-level element displayed in the *Elements Impacted* section.
- Double-click an element.
  - The view updates to display the element’s information.
- Position the cursor over an element.
  - Tooltip status information displays for the element.
- Right-click an element, then select a menu option.
  - For details on these options, see Appendix B, “Element and Alarm Options,” on page 107.

### 4.5.3 Navigating Impacted or Root Cause Elements

In addition to viewing the relationships between elements in the *Network* view, you can also view the elements that are affected by the current element (such as the *Impacted* view), and the elements that are affecting the current element (such as the *Root Cause* view).

To view impacted or root cause elements in the *Network* view:

1 Right-click the Network View drop-down list on the toolbar, and select one of the following:
- **Network:** Shows standard default view of an element and all its relationships
- **Impacted:** Shows the elements that are impacted by the selected element
- **Root Cause:** Shows what elements are causing the current state of the selected element

Elements in the view are filtered based on the selection.
4.5.4 Restricting the Show Impacted Feature

In some situations, you might want to exclude some Service elements from impact reporting. For example, if you use BSCM to generate automated tree views of elements that are used as building blocks for higher-level views (applications, services, and so on), the same element can display in the Show Impacted or Root Cause dialog box for multiple trees.

To exclude an element branch from impact reporting:

1. Right-click an element in the Services hierarchy, then select Properties to open the Status property page.
2. Select the Exclude from Impact Reporting check box.
3. Close the property page.
4. Click Yes when asked to save changes.
The Network view provides a dynamic graphical interface that enables moving across the entire enterprise, managing applications, servers, and network components.

The Network view displays relationships among system components within a large infrastructure. The Network view displays the selected element at the center, with spokes connecting to first-level child elements. Additional lines connect the first level elements to their children. The line colors identify the conditions of the child elements.

The Network view might not be available to users who are not in the administrators group if it was disabled. For more information, see "Disabling the Network and Layout Views" in the Operations Center Server Configuration Guide.

The element selected in the Explorer pane determines which elements display in the Network view and whether the entire network displays or only a portion of it. The elements displayed in the Network view also depend on user access privileges.

There are various ways to move around the Network view. Use menu options and toolbar buttons to view different levels of detail.

Initially, the element selected in the Explorer pane displays in the center of the Network view.

- Section 5.1, “Navigating the View and Exploring Element Hierarchies,” on page 41
- Section 5.2, “Changing the Viewing Level of the Elements,” on page 42
- Section 5.3, “Selecting the Magnification Level,” on page 43
- Section 5.4, “Customizing the Display,” on page 43
- Section 5.5, “Using Configuration Presets,” on page 44
- Section 5.6, “Rendering and Exploring Relationships,” on page 56

## 5.1 Navigating the View and Exploring Element Hierarchies

Use the navigational tools in the sidebar to locate and zoom in on objects:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Standard View" /></td>
<td>Standard View</td>
<td>Standard viewing mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Click an element to zoom and center it in the browser.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Double-click the layout background to center all the elements.</td>
</tr>
<tr>
<td><img src="image" alt="Marquee Zoom" /></td>
<td>Marquee Zoom</td>
<td>Zooms in to a specific area.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Click and drag to select an area.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To gradually zoom out, click the background.</td>
</tr>
</tbody>
</table>
A minimum of View security privileges to both elements in a relationship is required, or else the relationship is not displayed in the Network view. For more information on element security privileges, see the *Operations Center Security Management Guide*.

### 5.2 Changing the Viewing Level of the Elements

You can view elements at a higher or lower level than the selected element. *Table 5-2* provides some examples.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Pan Map Navigation" /></td>
<td>Pan Map Navigation</td>
<td>Click and drag to navigate across the entire layout.</td>
</tr>
<tr>
<td><img src="image" alt="Fisheye Zoom" /></td>
<td>Fisheye Zoom</td>
<td>Hover the cursor over an element to view element details.</td>
</tr>
<tr>
<td><img src="image" alt="Overview Navigator" /></td>
<td>Overview Navigator</td>
<td>Opens a small dialog box for viewing and navigation purposes.</td>
</tr>
<tr>
<td><img src="image" alt="Action Result" /></td>
<td></td>
<td>• Click and drag the cursor over the area to display. The Network view updates to zoom into the selected portion.</td>
</tr>
<tr>
<td><img src="image" alt="Action Result" /></td>
<td></td>
<td>A gray square displays over the selected portion of the diagram.</td>
</tr>
<tr>
<td><img src="image" alt="Action Result" /></td>
<td></td>
<td>• Click the gray navigational square and drag to a new position. The Network view updates to show the new selection.</td>
</tr>
</tbody>
</table>

A minimum of View security privileges to both elements in a relationship is required, or else the relationship is not displayed in the Network view. For more information on element security privileges, see the *Operations Center Security Management Guide*.

*Table 5-2*  *Network View Actions*

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>On the toolbar, click the <em>Up</em> button.</td>
<td>The selected element’s parent moves to the center of the <em>Network</em> view.</td>
</tr>
<tr>
<td>On the toolbar, click the <em>Home</em> button.</td>
<td>The top-level view displays. The <em>Elements</em> element displays at the center of the <em>Network</em> view with lines connecting to the first level elements.</td>
</tr>
<tr>
<td>Click and drag the network to center a different section on the screen.</td>
<td>A new section displays at the center of the <em>Network</em> view.</td>
</tr>
<tr>
<td>Double-click an element.</td>
<td>Drill into an element and view its children.</td>
</tr>
</tbody>
</table>
5.3 **Selecting the Magnification Level**

Click an element once or use the Zoom slider to increase or decrease the level of detail displayed in the *Network* view.

Moving the slider to the right, magnifies (zooms in) the existing network hierarchy. Move the slider to the left to zoom out. On the toolbar, click the Reset button to return to default view.

5.4 **Customizing the Display**

5.4.1 **Display Options**

Right-click the background of the Network view and select from the following display options:

- **Show Root**: Hide or display the element root (the topmost element).
- **Include Relationships in Layout**: Hide or display dependency connections.
- **Show Parent-Child Relationships**: Hide or display basic parent-child relationship connectors.

5.4.2 **Selecting Element Node Styles**

To change the node display type:

1. Right-click the view background and select one:

<table>
<thead>
<tr>
<th>Name</th>
<th>Display renders...</th>
<th>Sample Rendering</th>
</tr>
</thead>
<tbody>
<tr>
<td>Classic</td>
<td>Element nodes display similar to the classic Layout view.</td>
<td><img src="image" alt="Classic" /></td>
</tr>
<tr>
<td>Bubble</td>
<td>Element nodes display with rounded strong borders.</td>
<td><img src="image" alt="Bubble" /></td>
</tr>
<tr>
<td>Detailed</td>
<td>Element nodes display with larger boxes that show basic details about the element state.</td>
<td><img src="image" alt="Detailed" /></td>
</tr>
<tr>
<td>Tooltip</td>
<td>Element nodes display in narrow tooltip boxes.</td>
<td><img src="image" alt="Tooltip" /></td>
</tr>
</tbody>
</table>
5.5 Using Configuration Presets

The Network view includes several global layout configurations, called presets. Define configuration presets at the following levels:

- **Global**: A configuration available to all users.
- **User**: A configuration defined by a user and available only to that user.
- **Element**: A configuration setting saved and applied only to the current element in view.

To define configuration presets, review the following sections:

- Section 5.5.1, “Updating the Configuration for the Current Element,” on page 44
- Section 5.5.2, “Working with Global and User Presets,” on page 45
- Section 5.5.3, “Creating and Deleting Presets,” on page 47
- Section 5.5.4, “Using Layout Rendering Features,” on page 48

5.5.1 Updating the Configuration for the Current Element

It is possible to customize and save diagram settings for individual elements. This saved configuration is called an element preset.

A customized element preset takes precedence over global and user presets when displaying the element’s diagram. If no element preset exists, user presets take priority over global presets.

- “Modifying Configuration Settings” on page 44
- “Saving the Layout” on page 45

Modifying Configuration Settings

To modify configuration settings for the currently selected element:

1. Do one of the following to open the Edit Element Layout Properties dialog box:
   - In the sidebar, click Edit Element Layout Properties.
   - In the Control Panel, click the Edit element layout link.

2. In the sidebar, select a layout type:
   - **Tree**
   - **Circular**
   - **Orthogonal**
   - **Hierarchical**
   - **Organic**

3. The Style and other settings in the dialog box vary depending on the selected layout type. If necessary, update these settings. For more information to select the appropriate link, see “Using Layout Rendering Features” on page 48.
Saving the Layout

There are two ways to save the displayed view for the current element. Save the layout for the element only or save it for the class to which the element belongs. Saving a class layout automatically applies the saved layout to all elements in that class. If the *Save Element Layout* option is used, that layout displays when the Network view is open for the element. In other words, the saved element layout takes priority over the class layout.

- To save the layout for the current element only, right-click the Network view background, then select *Save Element Layout*.
  
  This saved layout is displayed when the Network view is open for the element.

- To save the layout for the class to which the element belongs, right-click the Network view background, then select *Save Element Class Layout*.
  
  This saved layout is displayed for any element in the class, unless a different layout was saved using the *Save Element Layout* option.

5.5.2 Working with Global and User Presets

To change the default global and user presets, use the Control Panel in the upper left corner of the view or use the sidebar icons.

*Figure 5-1  Control Panel*

*Figure 5-2  Sidebar Controls*

The following sections describe how to change both global and user presets as well as other settings:

- “Applying a Global or User Preset” on page 46
- “Modifying the Settings for a Preset” on page 46
- “Editing the Preset Name, Display Type or Global/User Setting” on page 46
Applying a Global or User Preset

The first step is selecting an existing global or user preset to see what it looks like when applied to an element.

To apply a global or user preset, do one of the following:

- In the sidebar, click Layout Preset, then select a preset from the drop-down list.

  **TIP:** The Layout Preset icon changes based on the current layout type selected.

- In the Control Panel, click the current Layout selection, then select a preset from the drop-down list.

The diagram updates using the selected preset. The next step is modifying the global or user preset.

Modifying the Settings for a Preset

1. Do one of the following to open the Manage Layout Presets dialog box:
   - In the sidebar, click Layout Preset, then select Manage Presets from the drop-down list.
   - In the Control Panel, click the current Layout selection, then select Manage Presets from the drop-down list.

2. Click the Layout Presets drop-down, then select the preset to modify.
   The settings update in the dialog box.

3. Edit the settings in the dialog box.
   The settings vary by layout style (Tree, Circular, and so on).
   For more information, see “Using Layout Rendering Features” on page 48.

4. To save the edited preset, do one of the following:
   - To apply the settings and keep the dialog box open, click Apply.
   - To save the settings and close the dialog box, click OK.

Editing the Preset Name, Display Type or Global/User Setting

1. In the Manage Layout Presets dialog box, click Edit Preset to open its dialog box.

2. Specify the name for the preset in the Layout Name field.

3. Click the Display Type drop-down list, then select the layout type.
   For more information, see “Using Layout Rendering Features” on page 48 for details on the different types.
4 To select a preset type, do one of the following:
- Select the *Global Preset Layout* radio button to make this layout available to all users.
- Select the *User Preset Layout* radio button to make this layout available in the user’s library of presets.

### 5.5.3 Creating and Deleting Presets

In some situations, creating a preset is preferable to modifying an existing preset. Review the following sections to create or delete a preset:

- “Creating a Preset” on page 47
- “Deleting a Preset” on page 48

#### Creating a Preset

1. Do one of the following to open the Manage Layout Presets dialog box:
   - In the sidebar, click `Layout Preset`, then select *Manage Presets* from the drop-down list.
   - In the Control Panel, click the current Layout selection, then select *Manage Presets* from the drop-down list.

2. In the Manage Layout Presets dialog box, click `New Preset` to open the Create Preset dialog box.

3. Specify the name for the new preset in the *Layout Name* field.

4. Click the *Display Type* drop-down list, then select the layout type.

5. To select a preset type, do one of the following:
   - Select the *Global Preset Layout* radio button to make this layout available to all users.
   - Select the *User Preset Layout* radio button to make this layout available in the user’s library of presets.

6. Click `OK`.
   The new preset displays as the current preset in the Manage Layout Presets dialog box.

7. In the Manage Layout Presets dialog box, select the layout style (*Tree*, *Circular*, and so on).
   The settings on the right side of the dialog box update.
   For more information, see “Using Layout Rendering Features” on page 48.

8. Edit the settings in the dialog box, which vary by layout style.
   For more information, see “Using Layout Rendering Features” on page 48.
Deleting a Preset

1 Do one of the following to open the Manage Layout Presets dialog box:
   - In the sidebar, click Layout Preset, then select Manage Presets from the drop-down list.
   - In the Control Panel, click the current Layout selection, then select Manage Presets from the drop-down list.

2 In the Manage Layout Presets dialog box, click the Layout Presets drop-down list, then select the preset.
   The settings update in the dialog box.

3 Click Delete to open a confirmation dialog box.

5.5.4 Using Layout Rendering Features

The Network view can render a hierarchy using the following layout styles:

<table>
<thead>
<tr>
<th>Layout Style</th>
<th>Renders…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tree</td>
<td>A tree-like structure with variations. Select from tree layout styles including: Directional, Balloon, Horizontal-Vertical, and Compact. For more information, see “Tree Layout” on page 50.</td>
</tr>
<tr>
<td>Circular</td>
<td>An interconnected ring or star topology. Layout emphasizes group structures within a network. It creates node partitions by analyzing the connectivity structure of the network, and arranging the partitions as separate circles. The circles are arranged in a radial tree layout. Select from circular layout styles including: BBC Compact, BBC Isolated, and Single Cycle. For more information, see “Circular Layout” on page 51.</td>
</tr>
<tr>
<td>Orthogonal</td>
<td>Members of a group share a common rectangular area. This produces compact drawings that are easy to read with no overlaps, few crossings, and few bends. Select from orthogonal layout styles including: Normal, Normal + Trees, Node Boxes, Uniform Node Sizes, and Mixed. For more information, see “Orthogonal Layout” on page 53.</td>
</tr>
<tr>
<td>Layout Style</td>
<td>Renders…</td>
</tr>
<tr>
<td>--------------</td>
<td>----------</td>
</tr>
<tr>
<td>Hierarchical</td>
<td>A visualization of hierarchical or pseudo-hierarchical scenarios. Portrays the precedence relation of directed graphs and highlights the main direction or flow within a directed graph. Automatically detects and resolves cyclic dependencies of nodes are. Places nodes in hierarchically arranged layers. Additionally, orders nodes within each layer to produce a minimal number of line (or edge) crossings. For more information, see “Hierarchical Layout” on page 54.</td>
</tr>
<tr>
<td>Organic</td>
<td>A clear representation of complex diagrams similar to ER diagrams or UML diagrams. Resulting layouts often expose the inherent symmetric and clustered structure of a graph, a well balanced distribution of nodes and few edge crossings. This is well suited for the visualization of highly connected backbone regions with attached peripheral ring or star structures. These structurally different regions of a network are easily identified in a diagram produced by this layout type. For more information, see “Organic Layout” on page 55.</td>
</tr>
</tbody>
</table>

These styles are listed in the sidebar of the Manage Layout Presets dialog box.

To manage layout styles, review the following sections:

- “Understanding the Different Layout Styles” on page 49
- “Using a Different Layout Style” on page 55
- “Saving the Current Layout as an Element Preset” on page 55

**Understanding the Different Layout Styles**

Review the following sections for an understanding of the different layout styles:

- “Tree Layout” on page 50
- “Circular Layout” on page 51
- “Orthogonal Layout” on page 53
- “Hierarchical Layout” on page 54
- “Organic Layout” on page 55
Tree Layout

Table 5-4 lists the Tree layout styles. The resulting layout can differ from the examples shown because of the different structure elements, relationships, and layout options.

Table 5-4  Tree Layout Styles

<table>
<thead>
<tr>
<th>Style</th>
<th>Description</th>
<th>Sample Rendering</th>
</tr>
</thead>
<tbody>
<tr>
<td>Balloon</td>
<td>Generates subtrees in a radial shape around the parent node. Ideally suited for networks with a large number of nodes (such as 10,000 nodes).</td>
<td><img src="image1" alt="Balloon Rendering" /></td>
</tr>
<tr>
<td>Compact</td>
<td>Generates compact orthogonal tree drawings. Consider specifying a preferred aspect ratio (relation of width to height), which is useful when the layout needs to fit perfectly in the space available.</td>
<td><img src="image2" alt="Compact Rendering" /></td>
</tr>
<tr>
<td>Directional</td>
<td>Generates tree drawings with a root node. Nodes are arranged either from top to bottom, left to right, or bottom to top. Mainly used for directed trees that have a unique root element. Route edge connectors as either straight lines or multisegmented lines.</td>
<td><img src="image3" alt="Directional Rendering" /></td>
</tr>
</tbody>
</table>
Circular Layout

Table 5-5 lists the Circular layout styles. The resulting layout can differ from the examples shown because of the different structure elements, relationships, and layout options.

**Table 5-5  Circular Layout Styles**

<table>
<thead>
<tr>
<th>Style</th>
<th>Description</th>
<th>Sample Rendering</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal/Vertical</td>
<td>Generates subtrees with horizontal or vertical layout.</td>
<td><img src="image" alt="Sample Rendering" /></td>
</tr>
<tr>
<td>BCC Compact</td>
<td>Each partition represents a bi-connected component (BCC) of the graph. A bi-connected component consists of nodes that are reachable by two edge-disjointed paths. Nodes that belong to more than one bi-connected component are assigned exclusively to one partition.</td>
<td><img src="image" alt="Sample Rendering" /></td>
</tr>
<tr>
<td>Style</td>
<td>Description</td>
<td>Sample Rendering</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>BCC Isolated</td>
<td>Node partitions are formed the same way as for the BCC Compact style, except that all nodes belonging to more than one bi-connected component are assigned an isolated partition.</td>
<td><img src="image" alt="Sample Rendering" /></td>
</tr>
<tr>
<td>Single Cycle</td>
<td>Arranges notes in a single circle.</td>
<td><img src="image" alt="Sample Rendering" /></td>
</tr>
</tbody>
</table>
Orthogonal Layout

The Orthogonal layout provides the style options as shown in Table 5-6. The resulting layout can differ from the examples shown because of the different structure elements, relationships, and layout options.

Table 5-6  Orthogonal Layout Styles

<table>
<thead>
<tr>
<th>Style</th>
<th>Description</th>
<th>Sample Rendering</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>This layout does not change the node sizes. The drawing contains very few bends.</td>
<td><img src="image" alt="Normal Rendering" /></td>
</tr>
<tr>
<td>Normal + Tree</td>
<td>Same as Normal, except it processes larger subtrees using a specialized tree layout algorithm, which is better suited for tree-like structures than the original orthogonal layout style.</td>
<td><img src="image" alt="Normal + Tree Rendering" /></td>
</tr>
<tr>
<td>Uniform Node Sizes</td>
<td>Changes all node sizes to equal sizes before the processing the drawing.</td>
<td><img src="image" alt="Uniform Node Sizes Rendering" /></td>
</tr>
<tr>
<td>Node Boxes</td>
<td>Resizes nodes according to the number and position of their neighbors to reduce the overall number of bends.</td>
<td><img src="image" alt="Node Boxes Rendering" /></td>
</tr>
</tbody>
</table>
Hierarchical Layout

The Hierarchical layout provides the style options shown in Table 5-7 for rendering the diagram. The resulting layout can differ from the examples shown because of the different structure elements, relationships, and layout options.

Table 5-7  Hierarchical Layout Flows

<table>
<thead>
<tr>
<th>Layout Flow</th>
<th>Could render similar to …</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bottom to Top,</td>
<td></td>
</tr>
<tr>
<td>Top to Bottom</td>
<td></td>
</tr>
<tr>
<td>Right to Left,</td>
<td></td>
</tr>
<tr>
<td>Left to Right</td>
<td></td>
</tr>
</tbody>
</table>

Mixed
Similar to Node Boxes, except it resizes all nodes to an equal size by introducing additional bends and routing the last line segment of these edges nonorthogonally to their adjacent nodes.
Organic Layout

The Organic layout renders the layout based mainly on structures and relationships. Figure 5-3 is an example of a Network view rendered using the Organic layout type:

![Figure 5-3 Organic Layout](image)

Using a Different Layout Style

1. Do one of the following to open the Edit Element Layout Properties dialog box:
   - In the sidebar, click Edit Element Layout Properties.
   - In the Control Panel, click the Edit element layout link.

2. In the Edit Element Layout Properties dialog box, select a layout type in the sidebar (Tree, Circular, Orthogonal, and so on).

3. If necessary, modify the settings for the selected layout on the right side of the dialog box. These settings vary by layout type.
   For information on selecting the appropriate link, see “Using Layout Rendering Features” on page 48.

4. Click OK. The diagram updates to use the selected layout style.

Saving the Current Layout as an Element Preset

Layout style changes display for the current session only. Save them explicitly for future use.

To save the current layout as an element preset:

1. To save the current view as an element preset for future use, right-click the layout background, then select Save Element Layout.

2. To select and display the saved element preset, do one of the following:
   - In the sidebar, click Layout Preset, then select Current Element from the drop-down list.
   - In the Control Panel, click the current Layout selection, then select Current Element from the drop-down list.

The diagram updates using the element preset.
5.6 Rendering and Exploring Relationships

- Section 5.6.1, “Understanding Element Relationships,” on page 56
- Section 5.6.2, “Viewing Relationships and Dependancies,” on page 56
- Section 5.6.3, “Exploring Dependency Relationships,” on page 57

5.6.1 Understanding Element Relationships

The Network view diagram distinguishes between standard parent/child relationships and linked relationships that can occur between elements by displaying different connector styles. Table 5-8 describes the connector styles and the corresponding relationship types.

Table 5-8 Connector Styles

<table>
<thead>
<tr>
<th>Connector Type</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Basic parent-child connector" /></td>
<td>Basic parent-child connector. One element is a natural child of the other element, meaning it was created directly under its parent. This occurs most often in relationships between elements under the Elements root element.</td>
</tr>
<tr>
<td><img src="image" alt="Linked parent-child connector" /></td>
<td>Linked parent-child connector. One element is a linked child of the other element. This occurs in the Services hierarchy when a child element is linked using the Link option. It contributes to the condition of the linked parent.</td>
</tr>
<tr>
<td><img src="image" alt="Dependency connector" /></td>
<td>Dependency connector. One element is dependent on the other element. This occurs when dependency relationship information is available, mostly through the use of Discovery Tools. For information about the discovery tools that Operations Center supports, see the Operations Center Adapter and Integration Guide.</td>
</tr>
</tbody>
</table>

5.6.2 Viewing Relationships and Dependancies

The diagram expands to display additional elements. Based on the relationship types selected, connectors and nodes display to depict the additional relationships.

To view additional relationships:

1. Right-click an element and select:
   - **Isolate**: Select Full to display only the element and its parent. Select Partial to display the entire branch leading to the element.
   - **Expand > Children**: Select this check box to display the element's children in the view.
   - **Explore Dependencies** Opens the Explore Dependencies dialog box so you can view an element's dependencies on other elements.

2. Right-click a connector and select Properties to view information showing how the two elements are linked.
Dependency relationships connectors display in blue with labels to show the relationship type, as shown in the previous table and illustration.

**TIP:** Use the element right-click *Navigate Relationships* option to quickly view an element’s dependency relationships and navigate to one of the end-point elements named in a relationship. For more information, see “Analyzing Dependencies” in the “Operations Center Service Modeling Guide”.

5.6.3 Exploring Dependency Relationships

A minimum of View security privileges to both the origin and end point elements in a relationship is required, or else the relationship is not displayed in the Explore Dependencies dialog box. For more information on element security privileges, see the *Operations Center Security Management Guide*.

To explore dependencies:

1. In the Network view, right-click the element node, then select *Explore Dependencies*.
2. In the Explore Dependencies dialog box, select a dependency.
   
   Dependency information displays in the right pane.
Using Find to Search for Elements

The Find feature allows you to search for elements in the Operations Center console. This functionality is also available when performing other tasks, such as creating behavior models or selecting a group of elements.

By default, search results are limited to 1,000 items for performance reasons. If you are getting a result set that is this large or greater, we recommend narrowing the search criteria. If you are not able to refine the search, we suggest setting up a Service View. For information about building a custom view, see the Operations Center Custom Drawing and Layout Guide and the Operations Center Service Modeling Guide.

The following sections explain in detail how to use various Find features to search for elements. Enhanced searching by metamodel classes and properties is explained in Section 6.3, “Using Metamodel Classes or Properties as Search Criteria,” on page 61.

- Section 6.1, “Conducting a Simple Find,” on page 59
- Section 6.2, “Using the Advanced Tab,” on page 60
- Section 6.3, “Using Metamodel Classes or Properties as Search Criteria,” on page 61

6.1 Conducting a Simple Find

Use the Basic tab to match an element’s name, class, condition (such as CRITICAL and OK), and property. The more information that you supply in the Basic tab, the more restrictive the search.

To search for elements using the Basic tab:

1. On the console toolbar, click Find to open its dialog box, displaying the Basic tab.
2. Click Browse to open the Browse for Element dialog box.
3. In the left pane of the Browse for Element dialog box, select the root element that contains the element, which is the target of the search.
4. Click OK to close the Browse for Element dialog box
5. In the Find dialog box, select the Include Sub-Elements check box to search all elements in the hierarchy.
6. Specify any combination of the following criteria for matching elements:
   - **Name**: Specify the name of the element to match:
     - Specify the complete element name to search for an exact match.
     - Use an asterisk to represent any number of characters as a wildcard for part of the element’s name. For example, typing green* finds green1, greenfield, and greenhouse.
   - **Class**: The class name to match.
   - **Condition**: Click the drop-down list, then select a condition.
Property: Specify the element property name. Select Equals or Not Equals to search for an exact match. Select Contains or Not Contains to search for a partial match.

Specify the property value.

Matching elements have or contain (or do not have or do not contain) the specified property value.

Limit: To limit the number of found elements, click the Limit drop-down list, then select a value. For example, if the limit is 50, the search displays only the first 50 elements found.

Depth: To limit the levels of child elements searched, click the Depth drop-down list, then select a value.

Time Limit: If the scope of the search is unknown, limit the search time to a specific number of minutes. Click the drop-down list, then select a value.

7 Click Search to start the search.

Search results display.

8 Perform any of the following actions:

- Double-click an element in the search results.
  The Explorer pane updates to display the element.
- Position the cursor over an element in the search results.
  Display status information and the entire path of where the element is located.
- Drag an element from the Find dialog box search results and drop it in the Layout view.
  Adds the element to a business service view.

6.2 Using the Advanced Tab

The Advanced tab provides a text area for entering a search query. Operations Center adheres to the standard search syntax defined in RFC 2254, The String Representation of LDAP Search Filters. For a comprehensive description of search syntax, see http://tools.ietf.org/rfcmarkup?rfc=2254.

To search for elements using the Advanced tab:

1 In the Find dialog box, click the Advanced tab to display it.
   The Advanced tab allows more complex searches.
2 Click Browse to open the Browse for Element dialog box, then:
   2a In the left pane of the Browse for Element dialog box, select the root element that contains the element which is the target of the search.
   2b Click OK to close the Browse for Element dialog box.
3 In the Find dialog box, select the Include Sub-Elements check box to include all subelements in the search.
4 In the Search criteria text area, specify the search criteria using any of the following operators:
   =
   <
   >
   <=
   >=
The syntax allows entering one or more attribute/value pairs, surrounded by parentheses, and logically combined with “&” (AND) or “|” (OR) operators. For example:

<table>
<thead>
<tr>
<th>To find...</th>
<th>Do this...</th>
</tr>
</thead>
</table>
| All objects starting with the same letters. | Specify wildcards using one or more asterisks (*). For example, to find all objects that begin with server, enter the query as:  
\[(cn=server*)\] |
| All host objects. | Specify \((objectClass=\text{*host*})\) to find all host name objects, all ServerHosts, and so on. |
| All hosts whose names begin with the letters server. | Combine two \(\text{attr=value}\) clauses using the logical AND (\&) operator:  
\[\&(cn=\text{server*})(objectClass=\text{*host*})\]  
Notice how the logical operator appears before the two clauses; this is called prefix notation. |
| All hosts whose names begin with the letters server and are in a CRITICAL state. | Enter:  
\[\&(\&(cn=\text{server*})(objectClass=\text{*host*}))\{condition=\text{CRITICAL}\}\] |
| All hosts whose names begin with the letters server and are in either a CRITICAL or WARNING state. | Enter:  
\[\&(\&(cn=\text{server*})(objectClass=\text{*host*}))\{|\{condition=\text{CRITICAL}\}\{condition=\text{WARNING}\}\}\] |
| Host names that begin with specific letters and are members of a specific object class. | Enter:  
\&(objectClass=\text{Router})(hostname>\text{B*})\] |
| Elements that are members of a specific class and have a response time greater than or equal to a specified threshold value. | Enter:  
\&(objectClass=\text{server})(responseTime>=3.4)\] |

5 Click Search to start the search to display the Search results.
6 Sort the found elements by clicking any column heading.

### 6.3 Using Metamodel Classes or Properties as Search Criteria

If the Administrator has enabled enhanced features to find elements based on specific metamodel classes or custom properties, an enhanced Basic tab displays.

You can specify search criteria for classes and properties, or click the arrow button, then select predefined custom class or property.

When typing search criteria in the Class or Property fields, standard * wildcard can be applied. For example, *Class* matches MyClassName and YourclassName.
In addition, you can filter elements based on multiple condition levels. By default, all conditions are included. Click a condition color to exclude elements that have that condition from the “found” list.

Instructions for enabling these enhanced Find features are in “Using Classes and Properties to Enhance Finding Elements” in *Operations Center Service Modeling Guide*. 
7 Filtering and Managing Alarms

The Alarms view displays a list of all alarms that occurred for an element selected in the Explorer pane and that element’s children. Customize the Alarms view using display modification and filtering features. Alarm filtering is discussed in a separate section.

After analyzing alarms, select from several options to indicate the next course of action. The last section of this section explains how to view historical information about an alarm.

**WARNING:** If alarms are enabled for Enterprise, Administration, Elements, or Services nodes, verify there is sufficient memory to process a large number of alarms before trying to view them.

- Section 7.1, “Understanding the Alarms View and Alarm Types,” on page 63
- Section 7.2, “Viewing a Summary of Alarms,” on page 64
- Section 7.3, “Viewing Alarm Severity,” on page 65
- Section 7.4, “Performing a Simple Filtering of Alarms by Severity,” on page 65
- Section 7.5, “Filtering Alarms,” on page 66
- Section 7.6, “Normalizing Time across Computers,” on page 74
- Section 7.7, “Performing Alarm Operations,” on page 75
- Section 7.8, “Using Alarm Properties,” on page 79
- Section 7.9, “Viewing and Managing the Alarm History,” on page 80

7.1 Understanding the Alarms View and Alarm Types

Alarms are events associated with specific elements. Each alarm has a severity level. Alarms contribute to the condition of an element. Thus, monitoring an element’s state often involves analyzing the alarms associated with the element.

The Alarms view displays a list of all alarms that occurred for an element selected in the Explorer pane and for the element’s children.

The administrator defines the events and conditions that trigger an alarm.

Each alarm entry is color coded to identify its severity level. The severity filter buttons (located on the toolbar) identify the colors representing, from left to right, the most critical to the least critical alarms.

The Alarms view filters alarms based on the alarm type. The following information displays for both Real-Time and Historical alarms:

- Alarms
- Audit Events
- Outages (available for Historical only)
- Change events (Historical only)
  - For more information, see the Operations Center Version Tracking Guide.
- Service Level Breaches
Service Level Metrics

Text comments for an element

If the Service Warehouse database is unavailable, Historical alarms do not display in the Alarms view. However, it is possible to add new comments for these alarms. The new comments are added to the Service Warehouse database after it becomes available. An informational log message in the formula.trc file indicates that Operations Center could not retrieve the alarms because the database was unavailable. Additionally, no outages are created when the database is unavailable.

By default, Real-Time alarms display in descending order by the date and the time that the most recently reported alarms occurred. Service level breaches, outages dates, and times indicate when the breaches or outages occurred. The Alarms view provides information in the columns described in Table 7-1.

Table 7-1  Standard Alarms View Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Severity</td>
<td>Color codes indicate the severity of the alarm.</td>
</tr>
<tr>
<td>Element</td>
<td>Identifies the element that generated the alarm.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Identifies the date and time when the alarm was reported.</td>
</tr>
<tr>
<td>ID</td>
<td>Unique identifier that Operations Center generates for alarms.</td>
</tr>
</tbody>
</table>

It is possible to display other columns in the Alarms view. The column names vary, depending on the management system associated with the alarm. For more information, see Section 3.4.2, “Hiding, Displaying, and Selecting Columns,” on page 25.

To change the type of alarms displayed in the Alarms view:

1. In the Explorer pane, select an element.
2. Click the Alarms tab to display the Alarms view.
3. On the toolbar, click the alarms drop-down, then select an alarm type.

The Alarms view updates to display alarms of the selected type.

### 7.2 Viewing a Summary of Alarms

Alarm totals display in the title bar for all elements showing alarms. The alarms are listed under the title bar. When an element contains only one alarm, the summary displays the actual alarm.

Table 7-2 lists the areas of the console where you can view alarm summaries for an element.

Table 7-2  Alarm Summary Viewing Areas

<table>
<thead>
<tr>
<th>Area</th>
<th>Explanation and Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status Bar</td>
<td>The status bar located at the bottom of the console displays the total number of alarms and the number of alarms currently selected.</td>
</tr>
<tr>
<td>Element Tooltip</td>
<td>When you position the cursor over an element in the Explorer pane, a tooltip displays the most severe condition of all the element’s children and the total number of open alarms with the subtotals of each alarm severity level.</td>
</tr>
</tbody>
</table>
7.3 Viewing Alarm Severity

By default, all alarms display in the Alarms view. Use the Filter toolbar buttons to display or hide alarms based on severity level. For more information, see Filtering Elements and Alarms.

To manage shading and view alarm severity colors:

- Section 7.3.1, “Shading or Removing Shading from All Rows,” on page 65
- Section 7.3.2, “Viewing Alarm Severity Colors,” on page 65

7.3.1 Shading or Removing Shading from All Rows

By default, only the Severity column is shaded to match the alarm’s severity level. It is possible to shade all other columns with the alarm’s severity level color.

To highlight or remove severity highlighting of alarm rows:

1. From the Format menu, select or deselect Show Severity Colors.

Another option is displaying the alarm totals by severity in a dialog box that opens over the console.

7.3.2 Viewing Alarm Severity Colors

To view the alarm severity colors and the total number of alarms for each level:

1. From the Format menu, select Show Alarm Summary.
   - A dialog box opens, displaying the total number of alarms for each severity level.
2. Close the dialog box when finished viewing the alarm totals.

7.4 Performing a Simple Filtering of Alarms by Severity

In the Alarms views, all alarms display by default.

In the top toolbar, Filter toolbar buttons represent the different severity levels (Critical, Major, Minor, and so on) by showing the associated color. The number of alarms for each severity displays next to the button.

Use these Filter toolbar buttons to display or hide alarms in the view based on severity only.

For more information about creating more advanced alarm filters, see Chapter 7, “Filtering and Managing Alarms,” on page 63.

You can perform the following actions using the Filter section of the toolbar:

- Section 7.4.1, “Displaying All alarms,” on page 66
- Section 7.4.2, “Hiding Alarms,” on page 66
7.4.1 Displaying All alarms

To display all alarms:

1. Right-click any location in the Filter section of the toolbar, then select Reset Filter Settings.

7.4.2 Hiding Alarms

To hide alarms of a specified severity:

1. Click a colored icon to hide alarms having that severity.

7.4.3 Displaying Alarms of a Selected Severity

To display alarms of a selected severity:

1. Select or deselect the filter buttons:
   - Alarms with the selected condition display.
   - Alarms with the deselected condition disappear from the view.

7.4.4 Displaying Elements of a Specified Severity

To display elements of a specified severity:

1. Right-click any location in the Filter section of the toolbar, then select Critical/Major/Minor.

   Only the alarms with CRITICAL, MAJOR, or MINOR severity display.

7.5 Filtering Alarms

The Alarm Filter pane in the Operations Center console is available only for elements that can display alarms.

Alarms can be filtered using criteria based on one or more alarm properties, such as severity, element name, ID, or dates and times. Filtering is useful when you want to see a subset of alarms. For example, you can apply a filter to display only those alarms with a specified severity level and a time stamp within a specified date range.

Both administrators and users can create and apply alarm filters. Administrators can create alarm filters and apply them to service models or metamodel classes to select a subset of alarms. This provides a way to control the alarms seen by users when they open the Alarms view. Service model and class filters can be applied in the console, or through scripts.

Users can create and apply alarm filters in their own Alarm views. These filters do not affect other users’ view of alarms.
Users can define their own alarm filters using the *Alarm Filter* pane, which is located in the bottom left corner of the *Alarms* view.

Applying an alarm filter displays a subset of alarms in the *Alarms* view. For example, apply a filter to display only those alarms with a specific severity message or class, or alarms within a specific date and time range. Combine the filter criteria using AND or ANY logic, as explained in subsequent subsections.

Applying an alarm filter does not change the total number of alarms displayed next to each filter button at the top of the console. For example, if there are 100 CRITICAL alarms, but an applied filter removes these alarms from the *Alarms* view, 100 still displays next to the red filter button in the console tool bar.

**TIP:** Click and drag up the top border of the *Alarm Filter* pane to view many filters. Click and drag between column headings to resize filter columns.

To filter alarms, review the following sections:

- Section 7.5.1, “Displaying or Hiding the Alarm Filter Pane,” on page 67
- Section 7.5.2, “Creating an Alarm Filter,” on page 67
- Section 7.5.3, “Applying Filters,” on page 72
- Section 7.5.4, “Changing Filter Order,” on page 73
- Section 7.5.5, “Editing and Deleting Filters,” on page 73
- Section 7.5.6, “Reapplying Filters to Update the Alarms View,” on page 73
- Section 7.5.7, “Disabling Filters,” on page 74
- Section 7.5.8, “Resolving Filters with No Data in Alarms View,” on page 74

### 7.5.1 Displaying or Hiding the Alarm Filter Pane

To hide or show the Alarm Filter pane:

1. From the *Format* menu, select *Show Alarm Filters*.
   - When selected, the *Alarm Filter* pane displays.
2. To hide the Alarm Filters pane, deselect *Show Alarm Filters* from the *Format* menu.

### 7.5.2 Creating an Alarm Filter

The options available for a filter depend on the adapter associated with the currently selected element.

To create an alarm filter:

1. In the *Explorer* pane, select an element.
2. Click ![Create](create_icon) in the *Alarm Filter* pane to open its dialog box.
3. In the *Filter Name* field, specify a name for the filter.
   - The name can contain between 1-50 alphanumeric or space characters only.
4. Do one of the following to determine the type of match: Select the *Match All* radio button to determine if an alarm must match any or all of the condition statements in order to be selected.
   - Select the *Match any of the following* radio button to match one or more condition expressions. Selecting this option joins more than one statement with an OR operator.
• Select the *Match all of the following* radio button to match all of the condition expressions. Selecting this option joins more than one statement with an AND operator.

• Select the *Custom boolean expression* radio button to specify a boolean expression to match.

For more information, see the table in Step 8.

5 To determine how the condition statements are applied in the filter, do one of the following: or *Match all of the following* radio button to determine if an alarm must match any or all of the condition statements in order to be selected.

• Select the *Match any of the following* radio button to match one or more alarm expressions. Selecting this option joins the statements with an OR operator.

• Select the *Match all of the following* radio button to match all alarm expressions. Selecting this option joins statements with an AND operator.

For example, to view alarms that have a specific severity and ID prefix, create two filter statements, then select the *Match All* radio button to join the statements with an AND operator. This is seen as “and” at the beginning of the filter row for the second filter. If you select *Match Any*, “or” begins each subsequent filter row.

• Select the *Custom boolean expression* radio button to join the statements using a custom boolean expression.

6 Click *Add*.

A blank row displays for defining a filter statement.

7 Click the first drop-down list, then select the alarm column name to match in the filter.

The list varies among adapters and also depends on the currently selected element. For example, select *Date/Time* for the filter to search alarms based on the date and time they were received.

Depending on which filter you select, other fields are displayed.
8 Select comparison operators and specify match criteria using the other fields in the row.

When defining the alarm filters, refer to Table 7-3 to understand the relationships among the fields.

**Table 7-3  Alarm Filters - Parameters**

<table>
<thead>
<tr>
<th>Alarm Column Type</th>
<th>Operators</th>
<th>Match Criteria</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text-based (such as Element, Class, Status, Description)</td>
<td>contains, does not contain, is, is not, begins with, ends with</td>
<td>Specify an appropriate value based on the selected alarm column.</td>
<td>• For exact matches, use <em>is</em> or <em>is not</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• For partial matches anywhere in an alarm value, use <em>contains</em> or <em>does not contain</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• For partial matches using the first or last characters, use <em>begins with</em> or <em>ends with</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• For partial matches using the first or last characters, use <em>begins with</em> or <em>ends with</em>.</td>
</tr>
<tr>
<td></td>
<td>is greater than, is greater than or equal, is less than, is less than or equal, matches regex</td>
<td>Specify an appropriate value to compare to the alarm column value.</td>
<td>These are lexicographical comparisons.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Specify a regular expression to perform on the alarm column value.</td>
<td>In regular expressions, standard wildcards (?) and (*) are allowed, as well as standard operators such as OR, AND, or BETWEEN.</td>
</tr>
<tr>
<td>Alarm Column Type</td>
<td>Operators</td>
<td>Match Criteria</td>
<td>Notes</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Date, Time</td>
<td>is</td>
<td>Specify a date and time.</td>
<td>To select a date range, create a <em>before</em> and an <em>after</em> statement, joined by selecting <em>Match All</em>, or use <em>is between</em>.</td>
</tr>
<tr>
<td></td>
<td>is not</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>is before</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>is before or equal</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>is after</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>is after or equal</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>is less than</td>
<td>Specify a date/time interval to compare with the alarm date/time.</td>
<td>These are relative date/time comparisons. For example, to match dates that are within 30 days earlier than the current date, use the criteria: date/time is less than 30 days before the current date.</td>
</tr>
<tr>
<td></td>
<td>is more than</td>
<td></td>
<td></td>
</tr>
<tr>
<td>is within the last</td>
<td>specified</td>
<td>Specify an aligned interval based on a number of minutes, hours, days, weeks,</td>
<td>This is a comparison within an aligned interval that is inclusive to the current time interval. For example, to match dates that are within the current month and previous month, select <em>is within the last 2 months</em>. In this case, if the current date is July 15, the filter searches for dates between June 1 to July 31, but will any alarms from June 1 to July 15.</td>
</tr>
<tr>
<td></td>
<td>interval based on</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>number of minutes,</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>hours, days, weeks,</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>months, or months.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>is today</td>
<td>specified</td>
<td>Specify beginning and ending dates to compare with the alarm date.</td>
<td>These are comparisons based on the current date.</td>
</tr>
<tr>
<td>was yesterday</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>is between</td>
<td>specified</td>
<td>Specify beginning and ending dates to compare with the alarm date.</td>
<td>This is a comparison based on a date range.</td>
</tr>
<tr>
<td>Severity</td>
<td>is</td>
<td>Select from severity levels appropriate to the adapter.</td>
<td>Use <em>is not</em> to exclude all but one severity code.</td>
</tr>
<tr>
<td></td>
<td>is not</td>
<td></td>
<td>To select a contiguous range of severity codes, create two statements using <em>higher than</em> and <em>lower than</em>, joined by selecting <em>Match All</em>.</td>
</tr>
<tr>
<td></td>
<td>is higher than</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>is lower than</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Some examples of alarm filters:

- **Matching Alarm Dates and Times:** If you select *Date/Time* in the first drop-down list, you can select *Is Before* in the second drop-down list.

  Then, if the comparison involves a specific date and time, use the calendar selector to select a date.

  In some cases, a relative “rolling” date/time comparison is necessary. For example, a filter could select alarms that are within 30 days of the current date and time. Use the *is less than* or *is more than* operator to specify the time interval for comparing the current date and time. Also specify whether the filter should pull alarms that are before or after the current date and time.

- **Matching Exact Cases:** Case-sensitive matching in alarm filters is optional. When a text type alarm column is used in a filter, the *Case-Sensitive* check box is selected by default. This means that when searching for a specific text string, a match occurs only if each letter in the string matches exactly the string entered in the third field of the alarm filter.

  For example, if the *Status* alarm column values are all capitalized, such as *OPEN*, use all capital letters to enter the value for the alarm filter.

  If case matching is irrelevant in the search, then deselect the *Case-Sensitive* check box.

- **Matching Alarm Severity Codes:** When *Severity* is the selected alarm column, a drop-down list of severity codes and colors displays in the right column.

  The codes vary among adapters.

9 (Optional) Click *Add* to create another alarm filter.

The filter matches alarms with a date and time stamp before the specified date and time and a **CRITICAL** severity.
If the Custom boolean expression radio button was selected in Step 4, specify a boolean expression using alarm expression ids to indicate how the condition statements are to be applied:

- Expression ids display in the front of each condition statement.
- Use AND to join two expressions.
- Use OR to match any of two expressions.
- Use NOT to not match an expression.
- The boolean expression is not case-sensitive. Not all alarm expressions must be applied as boolean expressions can be formed in a way that ignores an expression. For example, if the following expression is used, (AF1 OR AF2) AND (NOT AF4), then AF3 would be ignored.

(Conditional) To automatically deactivate the filter upon logout from the console, select the Deactivate This Filter on Logout check box. To leave the filter activated from session to session, leave the check box deselected. Deactivating filters upon logout ensures that all alarms display after the next login. If filters remain active upon logout, the active filters apply automatically upon login and only the selected alarms display in the Alarms view. Problems might arise from not realizing that all alarms are not displayed.

Click OK to create the filter.

The new filter displays in the Alarm Filter pane.

### 7.5.3 Applying Filters

After creating filters, you can apply them to the Alarms view using the Alarm Filter pane. Multiple filters are applied using the AND operator, meaning the resulting alarm set must match all the active filters.

After applying a filter, the status bar at the bottom of the Alarms view displays the total number of alarms selected by the active filters, and identifies in red the number of alarms that are not displayed because of the filter.

To apply an alarm filter:

1. Do one of the following:
   - To include alarms selected by the filter in the Alarms view, click the Type drop-down list, then select Include.
   - To exclude alarms selected by the filter from the Alarms view, click the Type drop-down list, then select Exclude.

2. Select the Active check box to apply the filter.
   - It is possible to apply more than one filter at the same time.
   - Alarms must match all active filters in order to be selected.

3. Click Apply.
   - Alarms are selected based on the active filters and the “included” option. The selected alarms display in the Alarms view.
7.5.4 Changing Filter Order

Filters apply in the order in which they display in the Alarm Filter pane.

To change the order in which filters apply:

1. Select the filter in the Alarm Filter pane.
2. Click \( \uparrow \) (the up or down scroll arrow button) to move the filter.

7.5.5 Editing and Deleting Filters

- “Editing a Filter” on page 73
- “Deleting a Filter” on page 73

Editing a Filter

To edit a filter:

1. Select the filter, then click \( \text{Edit} \) to open the Alarm Filter dialog box.
2. Edit the filter.
3. Click \( \text{OK} \) to save changes to the filter.

Deleting a Filter

To delete a filter:

1. Select the filter, then click \( \text{Delete} \) to open the Delete Confirmation dialog box.
2. Click \( \text{OK} \) to confirm the deletion.
   The filter disappears from the Alarm Filter pane.

7.5.6 Reapplying Filters to Update the Alarms View

Alarm filters are reapplied and the Alarms view is updated when alarm activity occurs, such as when a new alarm is received, a condition filter is selected in the console toolbar, or the Apply button is clicked. However, it is possible to set a timer to reapply all alarm filters at a specified interval. This requires editing the /OperationsCenter_install_path/html/applet_params.xml file.

To specify a time interval for reapplying all alarm filters and updating the Alarms view:

2. Set the following parameter:

   \[ \text{param name="AlarmPanel.AlarmFilterTimerFrequency" value="900000"} \]

   The time interval is in milliseconds. 900000 equals 15 minutes:
7.5.7 Disabling Filters

To disable alarm filters and display all alarms in the Alarms view:

1. In the Alarm Filter pane, click Reset to clear all Active check boxes.
2. Click Apply.

All alarms display in the Alarms view.

7.5.8 Resolving Filters with No Data in Alarms View

In some situations, applying a filter results in no matching alarms; the Alarms view is blank. Attempting to edit a filter results in being unable to select a different alarm column value in the Alarm Filter dialog box.

For example, if Severity is the selected alarm column, it is the only option in the drop-down list. The reason for this behavior is there are no alarm columns currently available for editing (or creating) alarm filters.

To restore alarm data:

1. Deactivate the alarm filter by clicking to clear the Active check boxes in the Alarm Filter pane.
2. Click Apply.

The Alarms view updates to display one or more alarms.

It is now possible to edit the alarm filters.

7.6 Normalizing Time across Computers

In the Alarms view, new alarms that originate from servers in different time zones are converted to display a time stamp using the local time zone. For example, a new alarm arriving on a computer in New York displays a time stamp of 12 noon, but the same alarm displays as 9 a.m. in San Diego.

A timeskew is the difference between the current time on the server and client, regardless of their time zones. For example, the current time on the server is 8:05 a.m. while the current time on the client in the same time zone displays 8:07 a.m. By default, Operations Center automatically detects timeskews and adjusts the displayed time stamp to be the time of the client. The overall effect is to adjust new alarms so they display using the local current time of the client, adjusting for differences in time zones and absolute time differences between the server and client. The time skew occurs for both real-time and historical alarms displayed in the Operations Center console and dashboard.

In some situations, you might want to disable timeskewing. When you disable timeskewing, the time stamp is based on the time on the server, both for local time and time zone conversions.

By default, timeskewing is enabled.

To disable timeskewing:

1. From the console toolbar, select Format > Use Timeskew.

   The check mark next to the option disappears.

2. After selecting this option, either to enable or disable timeskewing, restart the console in order to see changes in all places.
7.7 Performing Alarm Operations

Alarm options vary by adapter and management system and are available only after selecting one or more alarms in the Alarms view. For a list of alarm options by adapter type, see Section B.2, “Understanding Alarm View Menus,” on page 110.

Some options have shortcut buttons listed on the Alarms menu. Also, the appropriate user access privileges are required for the ability to access some alarm operations.

This section discusses the following common alarm operations:

- Section 7.7.1, “Accessing Alarm Options,” on page 75
- Section 7.7.2, “Selecting Alarms,” on page 75
- Section 7.7.3, “Pausing and Resuming Alarm Updates,” on page 76
- Section 7.7.4, “Acknowledging Alarms,” on page 76
- Section 7.7.5, “Assigning Alarms,” on page 77
- Section 7.7.6, “Clearing Alarms,” on page 78
- Section 7.7.7, “Printing Alarms,” on page 79
- Section 7.7.8, “Exporting Alarm Data,” on page 79

7.7.1 Accessing Alarm Options

To select alarm options:

1. In the Alarms view, right-click an alarm, then select an option.

7.7.2 Selecting Alarms

There are several ways to select alarms in the Alarms view:

- “Selecting One Alarm” on page 75
- “Selecting Multiple Alarms” on page 75
- “Selecting Multiple Adjacent Alarms” on page 76
- “Selecting or Deselecting All Alarms” on page 76

Selecting One Alarm

To select an alarm:

1. Click the alarm in the Alarms view.
   The selected alarm is highlighted.

Selecting Multiple Alarms

To select non-contiguous alarms:

1. Press the Ctrl key while clicking each alarm.
   The selected alarms are highlighted.
Selecting Multiple Adjacent Alarms

To select multiple contiguous alarms:

1. Press the Shift key, then click the first and last alarms.
   This also selects all alarms in between the first and last alarms.

Selecting or Deselecting All Alarms

To select/deselect alarms:

1. From the Edit menu, select Select All.
   or
   Select Deselect All to deselect all alarms.

7.7.3 Pausing and Resuming Alarm Updates

After alarm selection occurs in the Alarms view, the server automatically pauses all updates to the Alarms view. On the toolbar, a blinking Resume button replaces the Pause button. The status bar in the bottom left of the console displays a PAUSED message with the date and time.

To resume continuous updating of alarms:

1. On the toolbar, click the Resume button to update the Alarms view.
   On the toolbar, the Pause button replaces the Resume button.
2. To resume alarm updates, press the ESC (Escape) key on the keyboard.

7.7.4 Acknowledging Alarms

The Acknowledge operation is useful for technicians who need to indicate that they reviewed, but did not solve the problem, and perhaps escalated it to the next level.

If another user deletes a paused alarm, the alarm continues to display in the Paused view.

To acknowledge alarms:

1. On the Alarms view toolbar, click the Acknowledge button to change the alarm status to ACK (ACKNOWLEDGED).
   Acknowledgements are designed to be short term in duration. Therefore, after the alarm server completes a cycle, the acknowledged alarm status is lost.

**IMPORTANT:** T/EC users’ accounts must have Manage permission in order to acknowledge an alarm.
7.7.5 Assigning Alarms

When supported by the management system, alarms can be assigned to any user who is a member of the same user group. The ability to assign alarms requires Manage permissions assigned by the administrator.

**NOTE:** The following functionality is only available when integrating to management systems — such as HP OpenView, IBM Tivoli NetView, HP ServiceCenter, and HP Service Manager — that support the assigning of alarms.

When available, leverage the following functionality to assign alarms:

- “Assigning Alarms to Another User” on page 77
- “Viewing Users to Whom Alarms Are Assigned” on page 77
- “Assigning Alarms to Yourself” on page 78

**IMPORTANT:** NetView and OpenView users should note that an operation could be unavailable based on the current state of the element. If unavailable, the operation cannot be selected from the menu because it is dimmed.

### Assigning Alarms to Another User

To assign an alarm to another user:

1. In the Alarms view, select the alarms to assign.
2. On the toolbar, click the Assign button.
   - The Browse for User dialog box opens and displays the names of all users in the system to whom alarms can be assigned.
3. Select the user’s name.
4. Click OK to close the Browse for User dialog box.
   - In the Alarms view, an additional column, Assigned To, displays and identifies the users to whom alarms are assigned.

### Viewing Users to Whom Alarms Are Assigned

To view alarm assignments:

1. Do one of the following:
   - In the Alarms view, review the Assigned To column for the alarms.
   - Double-click an alarm to open the alarm’s Properties page. The user to whom the alarm is assigned is listed.
Assigning Alarms to Yourself

The ability to assign alarms to yourself depends on the adapter type. Some adapters provide the Assign (or Claim) Responsibility option on the alarm right-click menu or from the Alarms menu.

Depending on the adapter and which alarm columns display, an Assigned column could be available in the Alarms view. Also view the assignment in the alarm’s Properties page. For more information, see Section 7.8, “Using Alarm Properties,” on page 79.

You have the following options in assigning alarms to yourself:

- “Assigning an Alarm to Yourself and Closing It” on page 78
- “Removing the Assignment and Leaving the Alarm Open” on page 78
- “Rejecting Responsibility for an Alarm” on page 78

Assigning an Alarm to Yourself and Closing It

To assign and close an alarm:

1. Right-click the alarm and then select Assign and Close.

Removing the Assignment and Leaving the Alarm Open

To deassign an alarm while leaving it open:

1. Do one of the following depending on the adapter:
   - Right-click the alarm, then select Deassign.
   - Right-click the alarm, then select Accept Responsibility.
   - This option is not available for all adapters.
   - Accepting responsibility indicates to other users that you are working on resolving the alarm and will close or clear it. Depending on the adapter and which columns display, a check mark displays in the Acpt column.

Rejecting Responsibility for an Alarm

To reject an alarm:

1. Right-click the alarm and select Deassign (reject) Responsibility.

7.7.6 Clearing Alarms

Clear alarms assigned to you after resolving the problem. The Clear option is unavailable for Audit alarms.

To clear alarms:

1. Select one or more alarms in the Alarms view, then click the Clear Selected Alarms button on the toolbar.
   - The alarm disappears from the Alarms view.
7.7.7 Printing Alarms

Selecting the Print option gives you the option of printing either the selected alarms or all the alarms in the Alarms view. It is necessary to pause alarm updates before accessing the Print option.

To print all alarms in the Alarms view:

1. Right-click one or more alarms, then select Print.
   A message opens with the following question:
   `Would you like to print just the selected alarms?`

2. Click Yes to print just the selected alarms.
   or
   Click No to print all the Alarms currently showing in the Alarms view to open the Print dialog box.

3. Select a printer, then click Print.
   Additional dialog box options are available, such as the number of copies to print and landscape, portrait, or reverse landscape orientation.

7.7.8 Exporting Alarm Data

Use the Export Data option to export selected alarm data to a comma-delimited file, for further analysis or printing. First configure the alarm columns using the options listed in Section 3.4, “Working with Tabular Data,” on page 24. Only the alarms columns displayed in the Alarms view are exported.

To export alarm data:

1. Right-click an alarm, then select Export Data to open the Save dialog box.

2. Specify a file name, then click Save.
   The file format is .csv (Comma Separated Value).
   A dialog box opens, informing you that the export process can take considerable time depending on the number of rows exported.

3. Click Yes to proceed.
   A dialog box confirms completion of the export.

7.8 Using Alarm Properties

Open the alarm property pages to view information such as the elements affected by the alarm, the alarm’s owner, and the initial and most recent dates and times. The content of the dialog box varies among the adapters associated with the selected elements.

- Section 7.8.1, “Viewing Alarm Properties,” on page 80
- Section 7.8.2, “Displaying a Different Alarm,” on page 80
- Section 7.8.3, “Printing Alarm Properties,” on page 80
- Section 7.8.4, “Copying Alarm Properties,” on page 80
7.8.1 Viewing Alarm Properties

To view an alarm properties:

1. Do one of the following:
   - Double-click an alarm in the Alarms view.
   - Right-click an alarm, then select Properties.

2. To open another property page, click a property page name in the left pane to display the page in the right pane.

7.8.2 Displaying a Different Alarm

To view the next or previous alarm:

1. Do one of the following:
   - Click Next to display the next alarm.
   - Click Previous to display the previous alarm.

7.8.3 Printing Alarm Properties

To print the alarm properties for the current alarm:

1. Click Print on the property page.

7.8.4 Copying Alarm Properties

Text-based alarm property values can be copied to the Clipboard for pasting in other applications.

To copy a single text property to the Clipboard:

1. Right-click the property, then select Copy to place the text on the Clipboard.
2. Paste the text in any other application.
3. To copy all text properties on the page, right-click the right side of the page background, then select Copy All.

The Copy and Copy All options are also available for text-based element properties.

7.9 Viewing and Managing the Alarm History

If the Data Warehouse is set up to store alarm history, the Alarms view can display the history of an alarm for a defined time period. Alarm history displays only if the administrator created a profile that has an associated Alarms expression and also started the profile.

- Section 7.9.1, “Viewing the Alarm History for Elements,” on page 81
- Section 7.9.2, “Changing the Dates for Displaying Historical Alarms,” on page 81
- Section 7.9.3, “Sorting Alarms,” on page 82
- Section 7.9.4, “Changing the Maximum Number of Historical Alarms Displayed,” on page 82
- Section 7.9.5, “Displaying Record Time,” on page 83
- Section 7.9.6, “Viewing Deleted Alarms in Historical Alarms,” on page 83
7.9.1 Viewing the Alarm History for Elements

To view the alarm history for elements:

1. In the Alarms view, select the Historical: Alarms option.
   In this example, select Historical Alarms to change the Alarms View display.

2. Click Retrieve to retrieve historical alarms, which shows historical alarms in the Alarms view.
   Historical alarms display for a specified time period.

The following describes this view:

- When an event occurs that triggers an alarm, a new row containing alarm information displays in the Alarms view.
- When the status of an alarm changes, a new row containing alarm information displays in the Alarms view.
- Alarms that contain historical data display in bold.
- An arrow button to the left of the Severity column indicates that the alarm has more information.
- You can do the following in this view:
  - Click the button to expand and view all entries for the alarm and the various times that the alarm information was received.
  - Click the symbol to expand the view and display additional historical alarms.
  - Click the button to collapse the alarm history and display only the most recent entry.

7.9.2 Changing the Dates for Displaying Historical Alarms

To update the date range for historical alarms:

1. Use the timeline buttons to adjust the time range for alarms.

The timeline buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Display Setup</td>
<td>Displays the time frame defined by a user-defined Start and End time or the selection of a saved bookmark.</td>
</tr>
<tr>
<td></td>
<td>Bookmark</td>
<td>Displays the time frame based on a selected bookmark. For more information about bookmarks, see Section 8.7, “Navigating with Charting Bookmarks,” on page 97.</td>
</tr>
<tr>
<td></td>
<td>Page Back</td>
<td>Moves the timeline backwards by an entire view.</td>
</tr>
<tr>
<td></td>
<td>Unit Back</td>
<td>Moves the timeline backwards by one unit of time.</td>
</tr>
</tbody>
</table>
Make adjustments by clicking and dragging the timeline to a new position using the following mouse actions:

<table>
<thead>
<tr>
<th>Mouse Click Action</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click and drag left.</td>
<td>Navigates forward.</td>
</tr>
<tr>
<td>Click and drag right.</td>
<td>Navigates back.</td>
</tr>
<tr>
<td>Shift+click ➤ or Shift+click ◄</td>
<td>Seeks the next occurrence of information forward ➤ or backward ◄ on the timeline.</td>
</tr>
<tr>
<td>Ctrl+click and drag left.</td>
<td>Zooms out on chart data.</td>
</tr>
<tr>
<td>Ctrl+click and drag right.</td>
<td>Zooms in to chart data.</td>
</tr>
<tr>
<td>Double-click.</td>
<td>Opens the Display Setup dialog box.</td>
</tr>
</tbody>
</table>

### 7.9.3 Sorting Alarms

By default, the Alarms History view lists alarms in chronological, ascending order. This means using the received time for the alarms to display the oldest alarms first, followed by the most recent alarms. Sorting service level breaches and outages uses the date and time when the breaches or outages occurred.

To reverse the alarm history sort order:

1. From the Format menu, select Reverse Alarm History Sort.

   When selected, the sort order is chronological, descending. When deselected, the sort order is chronological, ascending.

   The sort order is persistent across client sessions and is unique for each user.

### 7.9.4 Changing the Maximum Number of Historical Alarms Displayed

By default, a maximum of 1,000 historical alarms can display.

To change the maximum number of alarms displayed, in the Format menu, click Alarm History Query Limit, then select a value.

The possible values are 500, 1000, 2500, 5000, and 10,000.
7.9.5 Displaying Record Time

Some network management systems do not issue a new time/date stamp for each change or update to an alarm. However, it is possible to display and sort historical alarm changes using the date and time that Operations Center recorded changes for an alarm, called the Record Time.

To display or hide the Record Time column:

1. From the Format menu, select Query by Recorded Date.
   When selected, the Record Time column lists the dates and times that Operations Center recorded each modified alarm.

7.9.6 Viewing Deleted Alarms in Historical Alarms

After deleting a historical alarm, a red x displays in the far left column and a red line strikes through the alarm column data.

Deleted alarms display data for six columns only: Severity, Element, Date/Time, ID, Source Element, and Record Time.

7.9.7 Adjusting the Timeline between Real-Time and Alarm History Views

For alarms retrieved in the Alarm History view, the end time displayed in the timeline corresponds to the date and time when the timeline first displayed.

To view the most recent changes in the Alarm History view:

1. On the toolbar, click the alarms drop-down list, then select Real-Time Alarms to update the Alarms view.
2. Click Retrieve to update the Alarms view.
3. Make changes to one or more real-time alarms, such as by performing operations on them.
4. Click the alarms drop-down list, then select Historical - Alarms to update the Alarms view.
5. Click Retrieve.
   The most recent changes do not display because the end time is still set to the previous request's end time.
6. Advance the timeline to see the most recent alarm changes.

7.9.8 Viewing the Alarm History Property Page

The alarm History property page displays historical alarm information for a specific alarm.

To view the history of a specific alarm:

1. Do one of the following:
   - In the Alarms view, double-click an alarm.
   - Right-click an alarm, then select Properties.
2. In the left pane, click History.
   The History property page displays all available history for the selected alarm.
3 To view a different alarm, do one of the following:
   • Click Next to view the next alarm.
   • Click Previous to view the previous alarm.
Charting Performance Data

The Performance view graphs historical performance data for elements associated with specific management systems or with the Service Level Manager (SLM), which is a product of Operations Center for managing service level agreements (SLAs).

- Section 8.1, “Understanding the Performance View,” on page 85
- Section 8.2, “Understanding the Chart Types,” on page 86
- Section 8.3, “Charting Performance Data,” on page 90
- Section 8.4, “Viewing and Editing Chart Properties,” on page 94
- Section 8.5, “Setting Thresholds on Charts,” on page 95
- Section 8.6, “Navigating Performance Charts,” on page 96
- Section 8.7, “Navigating with Charting Bookmarks,” on page 97
- Section 8.8, “Adjusting Time Intervals,” on page 98
- Section 8.9, “Automatically Refreshing Chart Data,” on page 99
- Section 8.11, “Saving the Performance Chart Group to a Graphics File,” on page 100
- Section 8.12, “Exporting Data,” on page 100

For details on customizing default chart settings, see “Customizing Default Performance Chart Settings” in Operations Center Server Configuration Guide.

For information on using the Performance view in connection with SLM and SLAs, see “Analyzing Performance” in the Operations Center Service Level Agreement Guide.

8.1 Understanding the Performance View

Performance data is available for elements associated with:

- Some network management systems, such as BMC PATROL
  
  This data is automatically available for display in the Performance view for the elements associated with the management system.

- The Operations Center Service Level Manager (SLM), which is an optional feature
  
  SLM enables viewing historical performance data saved for elements. Ask your administrator if the company has purchased and configured SLM.

The key components of the Performance view are:

- **Explorer pane**: Lists elements. Select an element by clicking it. If performance information is available for a selected element, the associated properties display in the Chart Properties pane.

- **Chart Properties pane**: Lists the types of performance data that can be charted for the selected element.
• **Timeline:** Identifies the dates and times associated with the charted performance data. Provides tools for easy navigation of the Performance charts.

• **Chart pane:** Displays performance data for a selected element using a line chart, stacked bar chart, or condition line chart.

## 8.2 Understanding the Chart Types

Each chart property displays in one of the chart types described in Table 8-1.

**Table 8-1  Performance Chart Properties and Associated Chart Types**

<table>
<thead>
<tr>
<th>Chart Property</th>
<th>Associated Chart Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Column</td>
<td>Varies by data type.</td>
</tr>
<tr>
<td></td>
<td>A Line chart is created for most columns, except for Severity, which creates a Condition Line chart.</td>
</tr>
<tr>
<td>Alarm Severity Counts</td>
<td>Stacked Bar</td>
</tr>
<tr>
<td>Child Condition Counts</td>
<td>Stacked Bar</td>
</tr>
<tr>
<td>Element Condition Change</td>
<td>Condition (Line or Pie)</td>
</tr>
<tr>
<td>Element Condition</td>
<td>Condition (Line or Pie)</td>
</tr>
<tr>
<td>Element Property</td>
<td>Varies by data type.</td>
</tr>
<tr>
<td></td>
<td>A Line chart is created for most properties, and a Condition Line or Pie chart is created for some properties.</td>
</tr>
<tr>
<td>Performance Series</td>
<td>Line</td>
</tr>
<tr>
<td>Script</td>
<td>Varies by data type.</td>
</tr>
</tbody>
</table>

Other properties are also available to chart, depending on the properties captured, or if a Service Level Agreement is defined. For example, when a Service Level Agreement is applied with an availability objective, Availability and Outage Count properties are often available to chart.

**Table 8-2  SLA Property Types and Corresponding Chart Types**

<table>
<thead>
<tr>
<th>Property Type</th>
<th>Chart Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Availability</td>
<td>Line</td>
</tr>
<tr>
<td>Outage Count</td>
<td>Stacked Bar</td>
</tr>
</tbody>
</table>

When charting SLA metrics, it can take up to several minutes before a refreshed or new chart registers an update, while updates for other property types are received and charted in near-real-time. In this case, the server has not yet recorded update data for Availability and Outage Count properties.

When charting performance and SLA metrics, if there is no data for the time range selected, the chart displays with no data.
The following sections explain the four chart types:

- Section 8.2.1, “Line Charts,” on page 87
- Section 8.2.2, “Sted Bar Chart,” on page 88
- Section 8.2.3, “Condition Line Chart,” on page 89
- Section 8.2.4, “Condition Pie Chart,” on page 89

8.2.1 Line Charts

Line charts display property values (other than alarms and condition) for an element. For more information, see “Creating an Area Line Chart” on page 92.

There are two types of Line charts:

- The standard Line chart tracks values using a line on the Y-axis:

![Standard Line Chart Example]

- The Area Line chart fills in the range between zero and the line value:

![Area Line Chart Example]
The Line chart can render both warning and alarm thresholds for some elements (such as Event Manager and PATROL). In Figure 8-1, when the Write Cache Hit Ratio falls below 20, it issues a WARNING level (orange) violation. When it falls below 10, it issues a CRITICAL (red) violation.

**Figure 8-1** Line Chart: Some Performance Charts Include a Warning and CRITICAL Thresholds

8.2.2 Sted Bar Chart

The Sted Bar chart displays segmented values sted in a single bar for each time point.

In Figure 8-2, each sted bar shows the total number of alarms and segments each type of alarm condition (CRITICAL, MAJOR, MINOR, and so on) by color:

**Figure 8-2** Sted Bar Chart

You can identify the changes in the ratio of CRITICAL (red) versus OK (green) alarms over time.
8.2.3 **Condition Line Chart**

The Condition Line chart uses a line to track values over time.

*Figure 8-3* shows that the element condition fluctuates mostly between CRITICAL and MAJOR during the displayed time period:

*Figure 8-3  Condition Line Chart*

![Condition Line Chart](image)

The background band of colors helps identify the changes in conditions over time.

8.2.4 **Condition Pie Chart**

A Condition Pie chart is related to the Condition Line chart.

*Figure 8-4* shows the element was in CRITICAL and MAJOR condition for equal percentages of time, and in OK condition for the remaining 20 percent of the time:

*Figure 8-4  Average Condition Pie Chart*

![Average Condition Pie Chart](image)

The Pie chart identifies the percentage of time that the element was in each condition (CRITICAL, MAJOR, MINOR, and so on) within a specific time period.

For more information, see *"Creating a Pie Chart of Condition Values"* on page 92.
8.3 Charting Performance Data

The following sections describe the steps for selecting elements and properties to create performance charts:

- Section 8.3.1, “Creating Charts,” on page 90
- Section 8.3.2, “Refining the Displayed Chart,” on page 92
- Section 8.3.3, “Updating a Chart Group,” on page 93
- Section 8.3.4, “Refreshing Performance Data,” on page 94
- Section 8.3.5, “Removing Charts,” on page 94

8.3.1 Creating Charts

In the Performance view, the Chart Properties pane lists the types of performance information that has been gathered for an element, such as the number of alarms for each severity type (Alarm Severity Counts) and trending the changes in condition for an element (Element Condition).

The following topics are related to creating charts:

- “Creating a Chart in the Performance View” on page 90
- “Adding a Single Chart Quickly” on page 92
- “Creating an Area Line Chart” on page 92
- “Creating a Pie Chart of Condition Values” on page 92

Creating a Chart in the Performance View

To create a chart:

1. In the Explorer pane, select an element.
2. Click the Performance tab.
   The Performance view updates. A timeline selector displays at the top of the view pane.
3. To adjust the timeline to display a specific time frame, do one of the following:
   3a Table 8-3 describes the timeline icons you can use to adjust the timeline.

<table>
<thead>
<tr>
<th>Timeline Icons</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Setup</td>
<td>Displays the time frame defined by a user-defined Start and End time or the selection of a saved bookmark.</td>
</tr>
<tr>
<td>Bookmark</td>
<td>Displays the time frame based on a selected bookmark.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Section 8.7, “Navigating with Charting Bookmarks,” on page 97.</td>
</tr>
<tr>
<td>Page B</td>
<td>Moves the timeline backwards by an entire view.</td>
</tr>
<tr>
<td>Unit B</td>
<td>Moves the timeline backwards by one unit of time.</td>
</tr>
<tr>
<td>Page Forward</td>
<td>Moves the timeline forwards by an entire view.</td>
</tr>
</tbody>
</table>
3b Click and drag the timeline to a position using the actions described in Table 8-4.

Table 8-4  Mouse Click Actions

<table>
<thead>
<tr>
<th>Mouse Click Action</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click and drag left</td>
<td>Navigates forward in time.</td>
</tr>
<tr>
<td>Click and drag right</td>
<td>Navigates backward in time.</td>
</tr>
<tr>
<td>Shift+click or Shift+click</td>
<td>Seeks the next occurrence of information forward or backward in time.</td>
</tr>
<tr>
<td>Ctrl+click and drag left</td>
<td>Zooms out on chart data.</td>
</tr>
<tr>
<td>Ctrl+click and drag right</td>
<td>Zooms in to chart data.</td>
</tr>
<tr>
<td>Double-click</td>
<td>Opens the Display Setup dialog box.</td>
</tr>
</tbody>
</table>

Duplicate property names can exist. Two or more properties attached to an element can gather properties with the same name. If duplicate properties display in the Chart Properties pane, the associated profile name displays in parentheses.

4 To automatically display properties in the Chart Properties pane for the element selected in the Explorer pane, do any of the following:

- Select one or more properties in the Chart Properties pane.
- To select multiple properties, press the Ctrl key, then click the properties.
- To view chart profile information in a tooltip format, position the mouse over a property name.

Consider the following concerning the properties:

- Properties originate from either an external management system, such as PATROL, or from profiles created by the administrator.
- If many properties are available, expand the Chart Properties pane by dragging up its top border.
- If performance data is unavailable for the selected element, the Chart Properties pane is empty, meaning a chart cannot be created.

5 Click Create Chart.

The charts display as a chart group in the Performance view.

Depending on the number of selected chart properties, more than one chart might display. All charts created at the same time are considered in the same chart group. To understand the relevance of chart groups, see Section 8.3.3, “Updating a Chart Group,” on page 93.

When charting SLA metrics (Availability and Outage Count), it can take up to several minutes before a chart registers an update, while updates for other property types are charted in near-real-time. In this case, the server has not yet recorded update data for these properties.

6 To create additional charts, repeat Step 1 through Step 5.

Clicking the Create Chart button creates a new chart beneath the most recent chart in the Performance view. It is considered a separate chart group.
Adding a Single Chart Quickly

To add a chart quickly:

1 Double-click a property in the Chart Properties pane.
   The new chart displays in the Performance view. It displays with existing charts, but is a separate chart group.

Creating an Area Line Chart

The standard Line chart tracks values using a line on the Y-axis. The Area Line chart fills in the range between zero and the line value.

To create an Area Line chart:

1 Create a standard Line chart.
   For instructions, see the steps listed earlier in this section.
2 In the Performance view, right-click the chart, then select Filled.
   When selected, the Area Line chart displays. When deselected, the standard Line chart displays.

Creating a Pie Chart of Condition Values

To show average condition values in a pie chart:

1 Create a Condition Line chart. For instructions, see the steps listed earlier in this section.
2 In the Performance view, right-click the Condition Line chart, then select Show Average in Pie Chart.
   A Pie chart opens in a separate dialog box.

8.3.2 Refining the Displayed Chart

Selecting too many data points can create an illegible chart. Also, all data points might not display in the chart. Magnify one area of the chart for a better view of data points. Other chart refinements include hiding profile names in the Chart Properties pane, to make it easier to see when numerous properties exist.

- "Magnifying an Area of a Chart" on page 92
- "Displaying or Hiding Profile Names in the Chart Properties Pane" on page 93

Magnifying an Area of a Chart

To zoom and magnify a chart:

1 Use the Zoom feature to magnify the display and refresh the data.
   For more information, see Navigating Performance Charts and Navigating with Bookmarks.
Displaying or Hiding Profile Names in the Chart Properties Pane

To hide or show profile names in chart properties:

1. Right-click the background of the Chart Properties pane, then select Show Profile.

When selected, the profile names display.

8.3.3 Updating a Chart Group

Charts display in chart groups in the Performance view. Clicking the Create Chart button creates a new chart group. A chart group can contain one or more charts, depending on the number of chart properties selected.

After creating a chart group, update charts in the group by making additional property selections or selecting a different element to chart.

**TIP:** Position the cursor over a data point to view a tooltip with relevant data for that point in time. For Condition charts, position the cursor over the actual data point (not the connector line).

To update a chart group:

1. In the Performance view, select the chart group.
   
   The element and properties used to create the charts appear highlighted in the Explorer pane and Chart Properties pane, respectively.

2. To chart a different set of properties for an element, select or deselect properties in the Chart Properties pane.

3. To create a chart for a different element:
   
   • Select a different element in the Explorer pane.
   
   • Then select properties in the Chart Properties pane.

4. Click Apply Changes to update the current chart group with the changes.

   For example, select three properties and create three charts, deselect a property, then click Apply Changes. The chart group redisplay using the last two selected properties, displaying only two charts.
8.3.4 Refreshing Performance Data

Data used to create a chart originates from the time the Performance view initially displayed. As time passes, it is necessary to refresh the chart with the most recent data from the native management system associated with the charted elements.

To refresh chart data:

1. Do one of the following in the Performance view:
   - Click a chart and then click Refresh on the toolbar.
   - Right-click a chart, then select Refresh Chart Group to refresh all charts in the group.

8.3.5 Removing Charts

To remove a single chart or the entire chart group:

1. Do one of the following:
   - Right-click a chart, then select Remove Chart.
   - The chart disappears from the Performance view.
   - Right-click a chart, then select Remove Chart Group.
   - All charts in the current chart group disappear from the Performance view.

8.4 Viewing and Editing Chart Properties

Access chart statistics through the chart’s property pages.

To view or edit the properties of a chart:

1. In the Performance view, right-click a chart, then select Properties to open the Properties dialog.
2. The Properties tab displays summary information about the chart.
   - For Condition charts, the Properties tab also displays the Pie chart described in Section 8.2.3, “Condition Line Chart,” on page 89. The minimum and maximum chart values display, along with total data points and dates and times of the first and last charted values.
3. In the left pane, click Times.
   - The Times tab displays the current time interval. Change the date range or time interval, if necessary. For details on editing the Times tab, see Section 8.8, “Adjusting Time Intervals,” on page 98.
4. Click Apply.
   - The chart updates using the specified date and time range.
5. In the left pane, click Display.
   - The Display tab in the Properties page displays options that enhance the chart display.
6. Specify the following in the fields provided:
   - **Chart Height**: Determines the height of the displayed chart.
   - **Minimum and Maximum Display Values**: Determines the range of values displayed on the chart’s Y-axis.
   - **Background Color**: The color that displays behind the chart data.
   - **Gradient Fill**: Used in combination with the background color.
**Show 3D:** Select the check box to display three-dimensional shapes.

**Show Major and/or Minor Grids:** Adds Y-axis lines that improve chart readability when there are many data points.

7. To apply the current settings to all charts that are subsequently created, click *Save to Defaults*.

8. Click *Apply* to refresh the chart using the changed settings.

or

To cancel changes before clicking the *Apply* button, click the *Reset* button to revert to the previously saved settings.

### 8.5 Setting Thresholds on Charts

- [Section 8.5.1, “Specifying a Horizontal Line on the Chart that Represents a Threshold Value,” on page 95](#)
- [Section 8.5.2, “Selecting a Threshold when Multiple Thresholds Have Been Set,” on page 96](#)
- [Section 8.5.3, “Drawing a Thicker Threshold Band,” on page 96](#)
- [Section 8.5.4, “Deleting the Current Threshold,” on page 96](#)

#### 8.5.1 Specifying a Horizontal Line on the Chart that Represents a Threshold Value

To setup a threshold line on a chart:

1. In the *Performance* view, right-click a chart, then select *Properties* to open the Properties page.
2. In the left pane, click *Thresholds* to display the Thresholds property page.
3. Click *Add New Threshold*.
4. Specify a value in the *Threshold Value* field.
   - The line is drawn at this value on the Y-axis.
5. Click the colored rectangle, then select a color from the palette.
6. Click *Apply*.
   - A horizontal line in the selected color displays across the chart along the specified threshold value on the Y-axis.
8.5.2 Selecting a Threshold when Multiple Thresholds Have Been Set

To select a threshold:

1. In the chart’s Thresholds property page, click the Threshold drop-down list, then select a threshold.

8.5.3 Drawing a Thicker Threshold Band

To expand the width of the threshold band:

1. In the chart’s Thresholds property page, select the Use Threshold Band check box.
2. Specify a second value in the To number box to draw the threshold band between the values specified in the To and Threshold Value number boxes.

8.5.4 Deleting the Current Threshold

To delete a threshold:

1. In the chart’s Thresholds property page, select the desired threshold in the Threshold drop-down list, then click Delete.
   The threshold setting disappears from the Threshold drop-down list.

8.6 Navigating Performance Charts

- Section 8.6.1, “Zooming In,” on page 96
- Section 8.6.2, “Scrolling,” on page 96

8.6.1 Zooming In

To zoom in to view increased levels of detail:

1. Click and drag a rectangle over a portion of the performance chart.
   The view zooms in to the selected area. This decreases the number of time intervals displayed, but increases the number of data points displayed.
2. Double-click the chart to return to the previous display level.

8.6.2 Scrolling

To scroll to display a different area of a chart:

1. Press the Shift key while clicking and dragging the chart.
2. Scroll right or left to view additional data along the X-axis.
3. Scroll up or down to view additional data along the Y-axis.
4. Double-click the chart to return to the previous display.
8.7 Navigating with Charting Bookmarks

Use bookmarks to move to a specific date and time in the timeline. Think of them as shortcuts to specific areas of a chart. This section explains how to add a bookmark, access a bookmark, manage existing bookmarks, and open a list for selection of bookmarks.

- Section 8.7.1, “Accessing Bookmarks,” on page 97
- Section 8.7.2, “Bookmarking the Current View,” on page 97
- Section 8.7.3, “Editing a Bookmark,” on page 97
- Section 8.7.4, “Deleting a Bookmark,” on page 97
- Section 8.7.5, “Displaying the Date and Time in the Performance View,” on page 98

8.7.1 Accessing Bookmarks

To access chart bookmarks:

1. Click the Bookmarks button in the top right corner of the Performance view.
   A menu and list of bookmarks display to the left.

8.7.2 Bookmarking the Current View

To bookmark the current view:

1. In the Performance view, click the Bookmarks button, then select Add Bookmark from the Bookmarks drop-down list to open the Bookmark Description dialog box.
2. Specify a name for the bookmark, then click OK.
3. The new bookmark for the current timeline selection displays in the Bookmarks drop-down list.

8.7.3 Editing a Bookmark

To edit a bookmark:

1. In the Performance view, double-click the timeline or click Display Setup to open the Display Setup dialog box.
2. Click the Bookmarks tab.
3. To edit a bookmark, select it, then click Edit.
   A dialog box with the bookmark’s name displays.
4. Edit the bookmark name in the Description field or change the start and/or end date and times.
5. Click OK to save the changes to the bookmark.

8.7.4 Deleting a Bookmark

To delete a bookmark:

1. In the Performance view, double-click the timeline or click Display Setup to open the Display Setup dialog box.
2. Click the Bookmarks tab.
3. Select a bookmark.
4 Click *Remove*.
   
   A confirmation dialog box displays.

5 Click *Yes* to remove the bookmark from the list.

8.7.5 **Displaying the Date and Time in the Performance View**

To display in the *Performance* view the date and time specified by a bookmark:

1 Double-click the timeline or click *Display Setup* to open the Display Setup dialog box.

2 Click the *Bookmarks* tab.

3 Select a bookmark.

4 Click *Go*.

   The *Performance* view updates to display data matching date and time specified by the bookmark.

8.8 **Adjusting Time Intervals**

- Section 8.8.1, "Changing the Chart Time Interval Using a Bookmark," on page 98
- Section 8.8.2, "Changing the Start and End Dates Used in a Chart," on page 98
- Section 8.8.3, "Changing the Time Interval Used in a Chart," on page 99

8.8.1 **Changing the Chart Time Interval Using a Bookmark**

To change the chart time interval using a bookmark:

1 In the *Performance* view, click *Bookmark*.

   A list of commonly used time intervals (such as last x minutes or hours) displays in the drop-down list.

2 Select a time interval.

   The chart updates to display data for the selected interval.

8.8.2 **Changing the Start and End Dates Used in a Chart**

To change start and end dates on a chart:

1 In the *Performance* view, double-click the timeline or click *Display Setup* to open the Display Setup dialog box.

2 Click the *Times* tab.

3 To select new starting or ending dates, do the following:

   - Select the *Use Date Range* radio button and enter a start and end date/time.
   - Select the *Use Current Date* check box to use the current date as the default end date.

4 Click *Apply*.

   The *Performance* view timeline updates to display the specified dates.

5 Click to close the dialog box.
8.8.3 Changing the Time Interval Used in a Chart

To change the time interval:

1. In the Performance view, double-click the timeline or click Display Setup to open the Display Setup dialog box.
2. In the Display Setup dialog box, select the Use Interval radio button.
3. Click the drop-down list, then select the time interval: Minutes, Hours, Days, Weeks, or Months.
4. Use the Last spinner to select the numeric increment.
5. Do one of the following:
   - To use a rolling time interval display, leave the Aligned check box deselected.
   - To use an aligned display, select the Aligned check box.
6. The Performance view timeline updates to display the specified time interval. Click Apply.
7. Click to close the dialog box.

8.9 Automatically Refreshing Chart Data

To refresh chart data at a specific time interval:

1. In the Performance view, click Bookmark, then select Auto Refresh to open the Auto-Refresh dialog box.
2. Specify the time interval (in seconds).
   - The minimum interval is 30 seconds.
3. Click OK.
   - The chart data updates continuously at the specified time interval:

8.10 Using Guidelines

Guidelines provide visual cues to help compare data from multiple charts at the same point in time.

- Section 8.10.1, “Creating a Guideline,” on page 100
- Section 8.10.2, “Moving a Guideline to a New Position,” on page 100
- Section 8.10.3, “Removing One or All Guidelines,” on page 100
8.10.1 Creating a Guideline

To create a guideline:

1. Right-click a point on the timeline at which to compare data, then select Add Guideline. A vertical guideline displays at the selected point.

8.10.2 Moving a Guideline to a New Position

To move the guideline:

1. Hover the cursor at the top of the guideline until the cursor changes to a hand symbol and drag to a new position on the timeline.

8.10.3 Removing One or All Guidelines

To delete the guideline:

1. Do one of the following:
   • Right-click the guideline, then select Remove Guideline.
   • To remove all guidelines, select Remove All Guidelines.

8.11 Saving the Performance Chart Group to a Graphics File

Save the performance chart group currently displayed as a .gif image.

To save the current chart group as a .gif file:

1. Select the chart group.
2. From the File menu, select Save Graphic to open the Save dialog box.
3. Specify a file name with the .gif extension.
4. Click Save to open a confirmation dialog box.
5. Click OK.
   All charts in the current chart group are saved in the single .gif file.

8.12 Exporting Data

It is possible to save performance data as a comma-separated text file. Appropriate access privileges are required to save the performance data. Inadequate privileges results in the message "Failed to save data. The privilege to do so may have been denied." when attempting to save performance data. Contact the administrator to request the permission to export the performance data.

To export performance data from a chart:

1. Do one of the following:
   • Right-click a chart, then select Export Performance Data.
   • From the File menu, select Export Performance Data to open the Save Data dialog box.
2 Specify a file name with a .txt extension.
3 Click Save to open a confirmation dialog box.
4 Click OK.
Main Menu Options

Menu options appear throughout the console. Some options display on the menu bar. Options vary depending on the current view. Right-clicking an element accesses many element-related options. This section lists and defines the available options.

Table A-1 summarizes the options available from the main menu bar for most views.

Table A-1 Standard Menu Options

<table>
<thead>
<tr>
<th>Menu</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>New Browser</strong>: Opens a new browser.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Change Password</strong>: Changes the logon password.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Logoff</strong>: Logs out of Operations Center and ends the current session.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Logoff and Exit</strong>: Logs out of Operations Center and completely exits the program.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>Find</strong>: Searches for an element based on specified criteria.</td>
</tr>
<tr>
<td></td>
<td>• For the <strong>Alarms</strong> view, the <strong>Edit</strong> option menu includes the following additional options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Select All</strong>: Selects all alarms.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Deselect All</strong>: Deselects all alarms.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Pause</strong>: Pauses all alarms.</td>
</tr>
<tr>
<td><strong>Go</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>B</strong>: Displays the previous view.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Forward</strong>: Displays the next view. Used with B to retrace steps during the current session. Cannot be used when viewing the most recent window.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Up One Level</strong>: Moves up one level in the hierarchy displayed in the <strong>Explorer</strong> pane.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Home</strong>: Selects the top level of the current element’s branch in the <strong>Explorer</strong> pane.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Summary</strong>: Changes the view to <strong>Summary</strong> and displays the child elements of the element selected in the <strong>Explorer</strong> pane.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Portal</strong>: Changes the view to <strong>Portal</strong> and provides a gateway into different areas of information about the selected element. Useful for administrators.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Network</strong>: Changes the view to <strong>Network</strong> and displays a graphical representation of the selected element in relation to other elements in the network.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Alarms</strong>: Changes the view to <strong>Alarms</strong> and displays a list of alarms for the selected element.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Layout</strong>: Changes the view to <strong>Layout</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Performance</strong>: Changes the view to <strong>Performance</strong> and displays graphs of performance data, if available, for the selected element.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Chat</strong>: Opens a dialog box for communicating with other console users. Console chat is not available for communication with dashboard users.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Alarm Window</strong>: Opens an independent alarm window for the selected element.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Go To Element</strong>: Changes the focus of the view to the associated element.</td>
</tr>
</tbody>
</table>
Menu | Options
--- | ---
**View** | - **Toolbars/Standard Buttons**: Displays or hides the standard window buttons.
- **Status Bar**: Displays or hides the status bar at the bottom of the console.
- **Explorer Pane**: Displays or hides the *Explorer* pane.
- **Default View**: Sets the default view that is opened whenever an element is selected in the *Explorer* pane. Contains the following suboptions:
  - **Specific view name**: Always displays this view by default.
  - **Auto-select**: Selects a view based on the element type.
  - **None**: Disables the default view. The view does not change after selecting an element in the *Explorer* pane.

**Format** | The *Format* options vary depending on the selected view. The *Layout* view has an extensive set of exclusive options.

| | For more information, see the *Operations Center Custom Drawing and Layout Guide*.
| | - **Background Color**: *(Layout view)* Provides a color palette for selecting a different background color.
| | - **Condition/Severity Color**: Provides a color palette for assignment to the condition or severity buttons.
| | - **Fit Columns**: *(Alarms view)* Resizes the *Alarms* columns based on the longest text string in each column.
| | - **Query by Recorded Date**: *(Alarms view)* Sorts and displays historical alarm changes using the dates and times when Operations Center recorded the alarm changes. Displays these dates and times in the *Record Time* column. Available only when alarm history displays in the *Alarms* view.
| | - **Restore Defaults**: *(Alarms views)* Resets the view to system defaults.
| | - **Reverse Alarm History Sort**: *(Alarms view)* Sorts alarm history entries in chronological, descending order (most recent to oldest). The sort order is persistent across client sessions and is unique for each user. When this option is deselected, the default sort order is used: chronological ascending order (oldest to most recent.) Available only when alarm history displays in the *Alarms* view.
| | - **Set Font**: *(Summary and Alarms views)* Sets the font size and style for the text displayed.
| | - **Show Alarm Summary**: *(Alarms view)* Opens a small window displaying the alarm severity colors and the number of alarm totals for each.
| | - **Show Severity Colors**: *(Alarms view)* Displays severity colors across the row of data.
| | - **Show/Hide Columns**: *(Alarms view)* Displays or removes columns.

**Element** | For *Element* menu options, see *Section B.1, Understanding Element Menus,* on page 107.

**Alarms** | These dynamic menu options display when the *Alarms* view is selected. The options vary depending on the adapter type associated with the alarm

| | For more information, see *Section B.2, Understanding Alarm View Menus,* on page 110.

**Window** | - **New Window**: Creates an additional View window.
| | - **Close Window**: Closes the current window.
| | - **Tile**: Arranges open View windows in a side-by-side format to fit within the console.
| | - **Cascade**: Sts open View windows behind the current window.
<table>
<thead>
<tr>
<th>Menu</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td>• <strong>Open Online Help</strong>: Displays the table of contents for the Operations Center online help.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Administrative Tasks</strong>: Displays the <em>Operations Center Server Configuration Guide</em> in online help.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Service Configuration Manager</strong>: Displays the “Introduction to the Service Configuration Manager (SCM)” section in the <em>Operations Center Service Modeling Guide</em> in online help.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Service Level Manager</strong>: Displays the <em>Operations Center Service Level Agreement Guide</em> in online help.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Data Integrator</strong>: Displays the <em>Operations Center Data Integrator Guide</em> in online help.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Event Manager</strong>: Displays the <em>Operations Center Event Manager Guide</em> in online help.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Dashboard</strong>: Displays the <em>Operations Center Dashboard Guide</em> in online help.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Configuring Adapters</strong>: Displays the <em>Operations Center Adapter and Integration Guide</em> in online help.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Cool Solutions Web Community</strong>: Displays the Cool Solutions Web Community for BSM on the NetIQ Web site.</td>
</tr>
<tr>
<td></td>
<td>• <strong>NetIQ Operations Center Home Page</strong>: Opens the Operations Center product page on the NetIQ Web site.</td>
</tr>
<tr>
<td></td>
<td>• <strong>About NetIQ Operations Center</strong>: Displays the current version and client and JAR information.</td>
</tr>
</tbody>
</table>


Element and Alarm Options

This appendix provides an overview of all element and alarm options. While your Administrator can create custom options, this gives you a description of standard Operations Center options available for elements and alarms:

- Section B.1, “Understanding Element Menus,” on page 107
- Section B.2, “Understanding Alarm View Menus,” on page 110

B.1 Understanding Element Menus

Element menu options vary depending on the adapter type associated with the selected element. Access element menus from the Explorer pane and the Summary, Network, and Layout views. To access element menus, right-click an element.

- Section B.1.1, “Right-Click Element Menu Options,” on page 107
- Section B.1.2, “Additional Menu Options in the Services Hierarchy,” on page 108
- Section B.1.3, “Additional Administrative Menu Options for Elements with Specific Adapters,” on page 109

B.1.1 Right-Click Element Menu Options

Table B-1 summarizes the element menu options.

Table B-1  Element Menu Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Opens the element property pages, which display detailed information about each element.</td>
</tr>
<tr>
<td>Alarms</td>
<td>Displays the Alarms view.</td>
</tr>
<tr>
<td>New</td>
<td>Opens a new Alarms dialog box for the selected element.</td>
</tr>
<tr>
<td>View</td>
<td>Changes the view to Summary, Portal, Network, Layout, or Alarms.</td>
</tr>
<tr>
<td>Add Comment</td>
<td>Enables creating annotations for the selected element. View comments in the element’s Comments property page.</td>
</tr>
<tr>
<td>Create Outage</td>
<td>Defines a manual outage for an element. For more information, see the Operations Center Service Level Agreement Guide.</td>
</tr>
<tr>
<td>Edit Blackout Calendar</td>
<td>Defines a blackout calendar requirement which halts data capture at times when the element has planned or unplanned maintenance, or down time that does not affect any other elements in the hierarchy. Available for Elements and Services root elements only.</td>
</tr>
<tr>
<td>Show Impacted</td>
<td>Identifies higher-level objects that are affected by the condition of the selected object. For details on Show Impacted, see the Section 4.5, “Viewing Root Cause and Impacted Elements,” on page 36.</td>
</tr>
</tbody>
</table>
### B.1.2 Additional Menu Options in the Services Hierarchy

Additional menu options exist for elements in the **Services** hierarchy.

Table B-2 describes the additional menu options for **Services** elements.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Relationships</td>
<td>Opens the Relationship Browser, which provides advanced layout features that enhance visualization and navigation of element relationships. For information on the Relationship Browser, see the <em>Operations Center Service Modeling Guide</em>.</td>
</tr>
<tr>
<td>Show Root Cause</td>
<td>Identifies objects that affect the condition change in a higher-level object. For details on Show Root Cause, see the Section 4.5, &quot;Viewing Root Cause and Impacted Elements,&quot; on page 36.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copies the element and its children. Use Paste to place a copy of the element elsewhere in the <em>Explorer</em> pane.</td>
</tr>
<tr>
<td>Cut</td>
<td>Cuts the element and its children. Use Paste to place a copy of the element elsewhere in the <em>Explorer</em> pane.</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes a copy of an element (and its children) as a child of the selected element. Pastes an element that was copied or cut from a different branch of the <strong>Services</strong> hierarchy. No link exists between a pasted element and the element from which it was copied or cut.</td>
</tr>
<tr>
<td>Add Element</td>
<td>Creates a new element under Locations or Service Models. For details on adding new elements, see the <em>Operations Center Service Modeling Guide</em>.</td>
</tr>
<tr>
<td>Manage Properties</td>
<td>Creates and manages custom property pages for an element in the <strong>Services</strong> hierarchy. These property pages apply to one element only. For more information, see the <em>Operations Center Service Modeling Guide</em>.</td>
</tr>
<tr>
<td>Remove</td>
<td>Its function is context sensitive. A confirmation dialog box lists the elements to remove, so you have the chance to review and if necessary, cancel the action.</td>
</tr>
<tr>
<td></td>
<td>• For most elements, <em>Remove</em> deletes the selected element and its children.</td>
</tr>
<tr>
<td></td>
<td>• For a source element that has linked elements created using the <em>Link Here</em> option, <em>Remove</em> deletes the source element and all its linked elements. For details on the <em>Link</em> option, see Section 3.1.3, &quot;Displaying Nonsource Element Indicators,&quot; on page 22.</td>
</tr>
<tr>
<td></td>
<td>• For an element created using the <em>Link Here</em> option, <em>Remove</em> deletes only the linked element.</td>
</tr>
<tr>
<td>Remove All Occurrences</td>
<td>Available only for an element that is linked to another <strong>Services</strong> element. Deletes the current element, the original element and all other linked copies of the element.</td>
</tr>
<tr>
<td>Rename</td>
<td>Renames the selected element. Allows the selection of a new class.</td>
</tr>
</tbody>
</table>
### B.1.3 Additional Administrative Menu Options for Elements with Specific Adapters

Table B-3 lists additional administrative menu options for elements using specific adapters.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Adapters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledge</td>
<td>Indicates that the selected alarms has been reviewed. Changes the Status column value to (Acknowledged). Used by technicians to indicate that they reviewed, but did not solve the problem, and perhaps escalated it to another level.</td>
<td>• BMC PATROL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tivoli NetView</td>
</tr>
<tr>
<td>Administration</td>
<td>Allows monitoring the element’s current status (Manage option), or stop monitoring an unimportant element to save bandwidth (Unmanage option). For details on managing and unmanaging elements, see Section 4.4, “Managing and Unmanaging Elements,” on page 35.</td>
<td>• Computer Associates Unicenter NSM</td>
</tr>
<tr>
<td>Console</td>
<td>Runs a script that executes a console connection, allowing direct communication with a managed element. Console capability is available for specific element types associated with a specific adapter. This means for a specific adapter, the Console option can be available for some elements, but not available for other elements. For information on console parameters for each adapter, see the Operations Center Adapter and Integration Guide.</td>
<td>• BMC PATROL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• BMC Patrol Enterprise Manager (PEM)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Cisco Info Center</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Computer Associates Spectrum</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Computer Associates Unicenter NSM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• HP OpenView NNM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• IBM Micromuse Netcool</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Operations Center Event Manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tivoli NetView</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tivoli T/EC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tivoli T/EC+</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• NetIQ</td>
</tr>
<tr>
<td>Jobs</td>
<td>Opens the console for interacting with Jobs. A job is a Knowledge Script that has been configured and scheduled to run once, at regular intervals, or at specific times on a given set of managed computers. The Knowledge Script contains a set of functions defined to manage some aspect of a system or application. Jobs are organized as parents and children, with only one level of children for any parent.</td>
<td>• NetIQ</td>
</tr>
<tr>
<td>Knowledge Module (KM)</td>
<td>PATROL agents receive information about the computers and applications in the environment from KMs. A KM contains information to identify objects and the actions to perform when monitored objects change status. The list of KMs displayed in the element menu varies, depending on whether existing KMs or custom KMs are used.</td>
<td>• BMC PATROL</td>
</tr>
</tbody>
</table>
**Table B-4  Alarm View Menus**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Adapters</th>
</tr>
</thead>
</table>
| Manage or Unmanage   | Allows monitoring the element's current status (Manage), or stop monitoring an unimportant element to save bandwidth (Unmanage). For details on managing and unmanaging elements, see Section 4.4, “Managing and Unmanaging Elements,” on page 35. | - HP OpenView Operations for UNIX  
- Tivoli NetView (only running on AIX and Solaris) |
| Ping                 | Opens a dialog box and attempts to contact or “ping” the selected element to test its network connection. The dialog box displays the number of bytes received and how long the message took. Click Stop to stop pinging the element. | - Computer Associates Unicenter NSM |
| Propagate            | Enables or disables the Propagate flag setting for WorldView objects within the NSM 2-D map. If you are using the Unicenter adapter, for more information see the Operations Center Adapter and Integration Guide. | - Computer Associates Unicenter NSM |
| Query Alert History  | Enables users to query historical alarms in the PEM persistent store. Users can specify start and stop date/time boundaries for displaying historical alarms. Historical alarms are displayed for the length of time specified using the PEM adapter properties. For more information, see the Operations Center Adapter and Integration Guide. | - BMC Software PATROL Enterprise Manager (PEM) |
| Severity             | Enables setting an alarm severity by selecting a submenu option (CRITICAL, MAJOR, MINOR, and so on). | - Computer Associates Unicenter NSM |
| Trace Route          | Displays the routing information through the network to the selected element. Displays the IP address for each hop, as well as the amount of time taken to connect to each segment. | - Computer Associates Unicenter NSM |

### B.2 Understanding Alarm View Menus

In the *Alarms* view, access menu options using the menu bar or by right-click an alarm. The menu options vary, depending on the adapter associated with the alarm. Table B-4 summarizes the menu options and lists the adapters for which the options are available.
<table>
<thead>
<tr>
<th><strong>Option</strong></th>
<th><strong>Description</strong></th>
<th><strong>Adapters</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledge</td>
<td>Indicates that the alarm has been reviewed. For more information, see Section 7.7.4, “Acknowledging Alarms,” on page 76.</td>
<td>• BMC PATROL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• HP OpenView Operations for UNIX</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• IBM Micromuse Netcool</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• NetIQ AppManager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tivoli Enterprise Console (T/EC) and T/EC+</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tivoli NetView</td>
</tr>
<tr>
<td>Add Annotation</td>
<td>Provides a field for entering information about the alarm. Used to document actions and read through previous actions.</td>
<td>• HP OpenView Operations for UNIX</td>
</tr>
<tr>
<td>Add Comment</td>
<td>Provides a field for entering information about the alarm. Used to document actions and read through previous actions. To view diary comments, open the Comments property page.</td>
<td>• BMC PATROL Enterprise Manager (PEM)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• NetIQ AppManager</td>
</tr>
<tr>
<td>Add Diary</td>
<td>Provides a field for entering information about the alarm. Document actions and read through previous actions. To view diary entries, open the Diary property page.</td>
<td>• BMC PATROL</td>
</tr>
<tr>
<td>Assign</td>
<td>Assigns responsibility for the alarm to a selected user. For more information, see Section 7.7.5, “Assigning Alarms,” on page 77.</td>
<td>• BMC PATROL Enterprise Manager (PEM)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• IBM Micromuse Netcool</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Operations Center Event Manager</td>
</tr>
<tr>
<td>Assign and Close</td>
<td>Assigns the alarm to you, then closes it.</td>
<td>• BMC PATROL Enterprise Manager (PEM)</td>
</tr>
<tr>
<td>Claim Responsibility</td>
<td>Assigns responsibility for the alarm to you. For information on assigning alarms, see Section 7.7.5, “Assigning Alarms,” on page 77.</td>
<td>• Operations Center Event Manager</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Adapters</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>Clear</td>
<td>Removes the alarm from the Alarms view. For more information, see Section 7.7.6, “Clearing Alarms,” on page 78.</td>
<td>• BMC PATROL Enterprise Manager (PEM)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Computer Associates Spectrum</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• HP OpenView Network Node Manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• IBM Micromuse Netcool</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Operations Center Event Manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tivoli NetView</td>
</tr>
<tr>
<td>Close</td>
<td>Changes the alarm status from Open or Acknowledged to Close, then removes it from the Alarms view.</td>
<td>• BMC PATROL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• NetIQ AppManager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tivoli Enterprise Console (T/EC) and T/EC+</td>
</tr>
<tr>
<td>DeAssign (reject) Responsibility</td>
<td>Removes the alarm assignment from the user selected by the Assign or Accept Responsibility option. The alarm can be reassigned.</td>
<td>• BMC PATROL Enterprise Manager (PEM)</td>
</tr>
<tr>
<td>Decrease Severity</td>
<td>Changes the alarm status to next lowest severity level. For example, a MAJOR alarm changes to a MINOR alarm. There is no change for an element in an OK state.</td>
<td>• HP OpenView Network Node Manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tivoli NetView</td>
</tr>
<tr>
<td>Delete</td>
<td>Permanently removes the alarm from Operations Center.</td>
<td>• BMC PATROL</td>
</tr>
<tr>
<td>Disown</td>
<td>Removes ownership from the alarm.</td>
<td>• HP OpenView Operations for UNIX</td>
</tr>
<tr>
<td>Escalate</td>
<td>Forwards the alarm to the ITO escalation server.</td>
<td>• HP OpenView Operations for UNIX</td>
</tr>
<tr>
<td>Group Assign</td>
<td>Assigns the alarm to the Public or System group.</td>
<td>• IBM Micromuse Netcool</td>
</tr>
<tr>
<td>Increase Severity</td>
<td>Changes the alarm status to the next highest severity level. For example, a MAJOR alarm changes to a CRITICAL alarm. There is no change for an in CRITICAL condition.</td>
<td>• HP OpenView Network Node Manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tivoli NetView</td>
</tr>
<tr>
<td>Journal</td>
<td>Provides a field for entering information about the alarm. Document actions and read through previous actions. To view the journal, open the alarm Journal property page.</td>
<td>• IBM Micromuse Netcool</td>
</tr>
<tr>
<td>Own</td>
<td>Claims ownership of the alarm.</td>
<td>• HP OpenView Operations for UNIX</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Adapters</td>
</tr>
<tr>
<td>----------</td>
<td>--------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Print</td>
<td>Prints all alarms in the Alarms view.</td>
<td>BMC PATROL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BMC PATROL Enterprise Manager (PEM)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Computer Associates Spectrum</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Computer Associates Unicenter NSM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HP OpenView Network Node Manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HP OpenView Operations for UNIX</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IBM Micromuse Netcool</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Operations Center Event Manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NetIQ AppManager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tivoli Enterprise Console (T/EC) and T/EC+</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tivoli NetView</td>
</tr>
<tr>
<td>Prioritize</td>
<td>Clears the alarm or changes its severity.</td>
<td>IBM Micromuse Netcool</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td><strong>Description</strong></td>
<td><strong>Adapters</strong></td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Properties</td>
<td>Opens the alarm property pages.</td>
<td>• BMC PATROL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• BMC PATROL Enterprise Manager (PEM)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Computer Associates Spectrum</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Computer Associates Unicenter NSM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• HP OpenView Network Node Manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• HP OpenView Operations for UNIX</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• IBM Micromuse Netcool</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Operations Center Event Manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• NetIQ AppManager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tivoli Enterprise Console (T/EC) and T/EC+</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tivoli NetView</td>
</tr>
<tr>
<td>Show Annotation</td>
<td>Displays text added using the Add Annotation option.</td>
<td>• HP OpenView Operations for UNIX</td>
</tr>
<tr>
<td>Start Automatic</td>
<td>Starts an action if an automatic action was configured for an alarm.</td>
<td>• HP OpenView Operations for UNIX</td>
</tr>
<tr>
<td>Action</td>
<td></td>
<td>• HP OpenView Operations for UNIX</td>
</tr>
<tr>
<td>Start Operator</td>
<td>Initiates an action to resolve an event that triggered an alarm. The Start Operator Action option displays in the menu only after configuring an operator initiated action for the alarm.</td>
<td>• HP OpenView Operations for UNIX</td>
</tr>
<tr>
<td>Action</td>
<td></td>
<td>• BMC PATROL Enterprise Manager (PEM)</td>
</tr>
<tr>
<td>Supervisor</td>
<td>Provides a submenu of options for users with Supervisor privileges:</td>
<td>• Acknowledge: Indicates that the alarm has been reviewed. For more information, see Section 7.7.4, &quot;Acknowledging Alarms,&quot; on page 76.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Close: Changes the alarm status from Open or Acknowledged to Close, then removes it from the Alarms view.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DeAcknowledge: Reverses the Acknowledge option.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Deassign: Removes alarm assignment from the user selected by the Assign or Accept Responsibility option. Leaves the alarm status Open. The alarm can be reassigned.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Adapters</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td>Suppress</td>
<td>Changes the alarm status to Suppressed and does not use the alarm severity to populate elements higher in the hierarchy. Often used by administrators who need additional time to troubleshoot issues related to an alarm.</td>
<td>Tivoli Enterprise Console (T/EC) and T/EC+</td>
</tr>
<tr>
<td></td>
<td>Alarms stay Suppressed until (a) the operator closes the alarm, (b) the alarm severity changes to OK, (c) the timer expires (see the Operations Center Adapter and Integration Guide), or (d) the operator unsuppresses the alarm with the Unsuppress Alarm right-click menu option.</td>
<td></td>
</tr>
<tr>
<td>Take Ownership</td>
<td>Assigns responsibility for the alarm to you. For more information, see Section 7.7.5, “Assigning Alarms,” on page 77.</td>
<td>IBM Micromuse Netcool</td>
</tr>
<tr>
<td>Unacknowledge</td>
<td>Reverses the Acknowledge option.</td>
<td>HP OpenView Network Node Manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tivoli NetView</td>
</tr>
</tbody>
</table>